USER'S MANUAL
Notice

The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.

©August 2004

Trademarks

This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is prohibited.

Intel and Pentium are registered trademarks of Intel Corporation.
FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.
IMPORTANT SAFETY INSTRUCTIONS

When using your telephone equipment, basic safety precautions should always be followed to reduce the risk of fire, electric shock and injury to persons, including the following:

1. Do not use this product near water, for example near a bathtub, washbowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (DC Output 20V, 3.25A minimum).

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELECOMMUNICATION LINE CORD
Instructions for Care and Operation

The computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don’t drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   - Do not expose the computer to any shock or vibration.
   - Do not place it on an unstable surface.
   - Do not place anything heavy on the computer.

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   - Do not expose it to excessive heat or direct sunlight.
   - Do not leave it in a place where foreign matter or moisture may affect the system.
   - Don’t use or store the computer in a humid environment.
   - Do not place the computer on any surface that will block the vents.
3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

<table>
<thead>
<tr>
<th>Do not turn off the power until you properly shut down all programs.</th>
<th>Do not turn off any peripheral devices when the computer is on.</th>
<th>Do not disassemble the computer by yourself.</th>
<th>Perform routine maintenance on your computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
</tbody>
</table>

5. **Take care when using peripheral devices.**

<table>
<thead>
<tr>
<th>Use only approved brands of peripherals.</th>
<th>Unplug the power cord before attaching peripheral devices.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td><img src="image6.png" alt="Image" /></td>
</tr>
</tbody>
</table>
Preface

Power Safety

The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC adapter or car adapter).

**Power Safety Warning**

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

**Do not plug in the power cord if you are wet.**

**Do not use the power cord if it is broken.**

**Do not place heavy objects on the power cord.**
Battery Precautions

- Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
- Recharge the batteries using the computer’s system. Incorrect recharging may make the battery explode.
- Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
- Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
- Keep the battery away from metal appliances.
- Affix tape to the battery contacts before disposing of the battery.
- Do not touch the battery contacts with your hands or metal objects.

Battery Disposal

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Caution

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Preface

**Touch Panel Care**
- Touch Panels are made of glass, so do not subject them to heavy shock or stress.
- Do not place heavy objects on the Touch Panel.
- Please use a dry soft cloth when cleaning (do not use any organic solvent acid or alkali solution).

**Cleaning**
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

**Servicing**
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:
- When the power cord or AC/DC adapter is damaged or frayed.
- If the computer has been exposed to rain or other liquids.
- If the computer does not work normally when you follow the operating instructions.
- If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
- If there is an unusual odor, heat or smoke coming from your computer.
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC adapter and cables. Stow them in the carrying bag.
5. The AC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the computer in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the vents/intakes to be blocked. To prevent your computer from overheating make sure nothing blocks the vent/fan intake while the computer is in use.
On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

**Hand-carry the computer** - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

**Beware of Electromagnetic fields** - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). **Note:** Some airports also scan luggage with these devices.

**Fly safely** - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the computer in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

**Get power where you can** - If an electrical outlet is available, use the AC adapter and keep your battery(ies) charged.

**Keep it dry** - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
- Take periodic breaks if you are using the computer for long periods of time.

Remember to:
- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Preface

Lighting
Proper lighting and comfortable display viewing angle can reduce eyestrain and muscle fatigue in your neck and shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.
Contents

Notice .................................................................I
Trademarks ...................................................I
FCC Statement ............................................II
Instructions for Care and Operation ...............IV
Power Safety ................................................VI
Battery Precautions .......................................VII
Touch Panel Care ..........................................VIII
Cleaning ....................................................VIII
Servicing ....................................................VIII
Travel Considerations ....................................IX
Remember to: ................................................I-XI

Introduction
Overview .......................................................1-1
Advanced Users ...........................................1-1
Beginners and Not-So-Advanced Users .............1-1
Warning Boxes ............................................1-2
Not Included ...............................................1-2
System Software ..........................................1-2
Quick Start Guide .........................................1-3
System Map ...............................................1-4
Model Differences .......................................1-4
Getting to Know Your Computer .....................1-5
Top View ................................................................1-6
The LCD Swivel Screen .................................1-7
Top View with LCD Open ...............................1-8
PC Camera ..................................................1-9
LED Power Indicators ....................................1-9
Cover Sensors .............................................1-10
LCD Swivel & Side Hinges ..............................1-11
Power Button ..............................................1-11
Stereo Speakers ..........................................1-11
Keyboard ...................................................1-12
TouchPad & Buttons .....................................1-12
Microphone ...............................................1-12
Front View ..................................................1-13
LCD Latches ...............................................1-13
Microphone-In Jack ......................................1-13
Headphone-Out Jack .....................................1-14
Infrared Transceiver .....................................1-14
LED Status Indicators ...................................1-14
Hot-Key Buttons .........................................1-15
Left Side View ............................................1-16
Security Lock Slot .......................................1-16
Vent .........................................................1-16
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td></td>
</tr>
<tr>
<td>Stylus Pen Holder</td>
<td>1-16</td>
</tr>
<tr>
<td>Right Side View</td>
<td>1-17</td>
</tr>
<tr>
<td>4-in-1 Flash Card Reader</td>
<td>1-17</td>
</tr>
<tr>
<td>Two USB 2.0 Ports</td>
<td>1-18</td>
</tr>
<tr>
<td>PC Card Slot</td>
<td>1-18</td>
</tr>
<tr>
<td>Rear View</td>
<td>1-19</td>
</tr>
<tr>
<td>External Monitor (VGA) Port</td>
<td>1-19</td>
</tr>
<tr>
<td>RJ-45 LAN Jack</td>
<td>1-19</td>
</tr>
<tr>
<td>RJ-11 Phone Jack</td>
<td>1-20</td>
</tr>
<tr>
<td>DC-In Jack</td>
<td>1-20</td>
</tr>
<tr>
<td>Vent</td>
<td>1-20</td>
</tr>
<tr>
<td>Bottom View</td>
<td>1-21</td>
</tr>
<tr>
<td>Stylus Pen Holder</td>
<td>1-21</td>
</tr>
<tr>
<td>Battery</td>
<td>1-21</td>
</tr>
<tr>
<td>Wireless LAN (Network) Module</td>
<td>1-22</td>
</tr>
<tr>
<td>Hard Disk Drive</td>
<td>1-22</td>
</tr>
<tr>
<td>Vent</td>
<td>1-22</td>
</tr>
<tr>
<td>Using The Computer</td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>2-1</td>
</tr>
<tr>
<td>The Power Sources</td>
<td>2-2</td>
</tr>
<tr>
<td>AC Adapter</td>
<td>2-2</td>
</tr>
<tr>
<td>Battery</td>
<td>2-3</td>
</tr>
<tr>
<td>Turning on the Computer</td>
<td>2-4</td>
</tr>
<tr>
<td>LED Indicators</td>
<td>2-5</td>
</tr>
<tr>
<td>LED Power Indicators</td>
<td>2-5</td>
</tr>
<tr>
<td>LED Status Indicators</td>
<td>2-6</td>
</tr>
<tr>
<td>Hard Disk Drive</td>
<td>2-7</td>
</tr>
<tr>
<td>The Floppy Disk Drive (Optional)</td>
<td>2-8</td>
</tr>
<tr>
<td>Inserting/Removing Floppy Disks</td>
<td>2-8</td>
</tr>
<tr>
<td>CD Device/DVD Device (Optional)</td>
<td>2-9</td>
</tr>
<tr>
<td>Optional CD/DVD Device Options</td>
<td>2-10</td>
</tr>
<tr>
<td>Loading CDs or DVDs</td>
<td>2-11</td>
</tr>
<tr>
<td>Handling CDs or DVDs</td>
<td>2-11</td>
</tr>
<tr>
<td>DVD Regional Codes</td>
<td>2-12</td>
</tr>
<tr>
<td>Changing DVD Regional Codes</td>
<td>2-13</td>
</tr>
<tr>
<td>4-in-1 Card Reader</td>
<td>2-14</td>
</tr>
<tr>
<td>PC Card Slot</td>
<td>2-15</td>
</tr>
<tr>
<td>Inserting and Removing PC Cards</td>
<td>2-15</td>
</tr>
<tr>
<td>Hot-Keys</td>
<td>2-16</td>
</tr>
<tr>
<td>The Keyboard</td>
<td>2-17</td>
</tr>
<tr>
<td>The Function Keys</td>
<td>2-17</td>
</tr>
<tr>
<td>Numeric Keypad</td>
<td>2-18</td>
</tr>
<tr>
<td>Touch Panel (Model A Only)</td>
<td>2-19</td>
</tr>
<tr>
<td>Handwriting Application (Optional)</td>
<td>2-22</td>
</tr>
<tr>
<td>ritePen Installation</td>
<td>2-22</td>
</tr>
<tr>
<td>ritePen</td>
<td>2-23</td>
</tr>
<tr>
<td>riteMail</td>
<td>2-24</td>
</tr>
</tbody>
</table>
Preface

TouchPad and Buttons/Mouse ........................................... 2-25
Configuring the Infrared Transceiver ................................. 2-26
Adding a Printer .......................................................... 2-27
USB Printer ............................................................... 2-27
Install Instructions: ...................................................... 2-27
Parallel Printer ............................................................ 2-28
Install Instructions: ...................................................... 2-28

Advanced Controls

Overview ................................................................. 3-1
Advanced Video Controls .............................................. 3-2
Opening the LCD ........................................................ 3-2
Video Memory ............................................................ 3-3
VGA Shared Memory ................................................... 3-3
Dynamic Video Memory Technology ................................ 3-3
Screen Rotation .......................................................... 3-4
Screen Rotation Driver .................................................. 3-4
“Q” Hot-Key ............................................................... 3-5
Video Driver Controls ................................................... 3-6
Making Adjustments for the Display ................................ 3-6
Display Properties ....................................................... 3-7
Intel Video Driver Controls ............................................ 3-8
Schemes ........................................................................ 3-10
Display Devices ........................................................... 3-11
Switching/Enabling Displays (Keyboard) ........................... 3-11
Switching/Enabling Displays (Driver) ............................... 3-12
Multi-Monitor Modes .................................................... 3-13
Intel(R) Dual Display Clone ............................................ 3-13
Extended Desktop ......................................................... 3-13
To Enable Dual Display Clone Mode: ................................ 3-14
To Enable Extended Desktop Mode: ................................ 3-15
To Enable Extended Desktop (Display Properties) .......... 3-16
Power Management Features ......................................... 3-17
Advanced Configuration and Power Interface ................. 3-17
Enabling Power Options ................................................ 3-18
Power Schemes ............................................................ 3-19
Conserving Power (System) ............................................ 3-21
Hibernate Mode vs. Shutdown ......................................... 3-21
Standby Mode vs. Hibernate Mode ................................ 3-21
Standby ......................................................................... 3-22
Hibernate ................................................................. 3-22
Configuring the Power Button ......................................... 3-23
Battery Information ........................................................ 3-24
New Battery ............................................................... 3-24
Battery Life ................................................................. 3-24
Battery FAQ ................................................................. 3-25
PC Camera ................................................................. 3-26
PC Camera Audio Setup ............................................... 3-27
(Win2000) ................................................................. 3-27
AMCAP ................................................................. 3-29
Preface

Set Capture File ...................................................... 3-29
Eliminating Screen Flicker ..................................... 3-30
Wireless LAN Module ........................................... 3-31

Drivers & Utilities
Overview .............................................................. 4-1
What to Install ...................................................... 4-2
Windows XP & 2000 Service Packs ....................... 4-2
New Hardware Found ............................................ 4-4
Authorized Driver Message ................................... 4-5
Version Conflict Message ...................................... 4-5
Updating/Reinstalling Individual Drivers ............... 4-5
Driver Installation .................................................. 4-6
  Automatic Driver Installation .............................. 4-6
Windows 2000 ...................................................... 4-8
  Chipset (Win2000) ............................................. 4-8
  Audio (Win2000) .............................................. 4-9
  Video (Win2000) .............................................. 4-9
  LAN (Win2000) ............................................... 4-9
  Modem (Win2000) ............................................ 4-9
  ENE-PCMCIA (Win2000) .................................. 4-10
  TouchPad (Win2000) ....................................... 4-10
  Wireless LAN (Win2000) ................................... 4-11
  PC Camera (Win2000) ..................................... 4-12
  Screen Rotation (Win2000) ............................... 4-13
  Touch Panel (Win2000) .................................... 4-13
Windows XP ....................................................... 4-14
  Chipset (WinXP) ............................................. 4-14
  Audio (WinXP) ............................................... 4-14
  Video (WinXP) ............................................... 4-15
  LAN (WinXP) .................................................. 4-15
  Modem (WinXP) .............................................. 4-15
  ENE-PCMCIA (WinXP) .................................... 4-16
  TouchPad (WinXP) .......................................... 4-16
  Wireless LAN (WinXP) ..................................... 4-17
  PC Camera (WinXP) ........................................ 4-19
  Screen Rotation (WinXP) ................................. 4-19
  Touch Panel (WinXP) ....................................... 4-20

BIOS Utilities
Overview .............................................................. 5-1
The Power-On Self Test (POST) .............................. 5-2
  Failing the POST ............................................... 5-3
  Fatal Errors ..................................................... 5-3
  Non-Fatal Errors .............................................. 5-3
The System Configuration Utility ............................ 5-4
  Entering Setup .................................................. 5-4
  Entering Setup with Display OEM Logo Enabled ... 5-4
  Working with the Menu Bar ............................... 5-5
  Working with the Pull-Down Menu ...................... 5-6
Filtered text representation:

Working with Sub-Menus ........................................5-7
Startup Menu ............................................................5-8
Fast Boot (Startup Menu) .........................................5-8
Boot Device (Startup Menu) ....................................5-9
Display (Startup Menu) ............................................5-9
Enable Battery Low Beep (Startup Menu) ...............5-9
Enable Power On Beep (Startup Menu) .................5-10
Display OEM logo (Startup Menu) ........................5-10
Fast Boot for Windows XP (Startup Menu) ...........5-10
Boot and SCU Passwords (Startup Menu) .............5-10
Memory Menu ........................................................5-11
VGA Shared Memory (Memory Menu) .................5-11
Disks Menu ............................................................5-12
IDE Settings (Disks Menu) ....................................5-12
Virus Alerts (Disks Menu) .....................................5-12
Components Menu .................................................5-13
COM Ports (Components Menu) .........................5-13
Keyboard Numlock (Components Menu) ..............5-14
Keyboard Repeat (Components Menu) ..................5-14
Power Menu ...........................................................5-15
Low/Medium/High/Custimize Power Saving (Power Menu) ..................................................5-16
CPU SpeedStep Controls (Power Menu) ...............5-16
Exit Menu ...............................................................5-17
Save and Exit (Exit Menu) ........................................5-17
Exit (No Save) - (Exit Menu) .................................5-18
Default Settings (Exit Menu) .................................5-18
Restore Settings (Exit Menu) .................................5-18

Upgrading The Computer
Overview ..............................................................6-1
When Not to Upgrade ............................................6-2
Removing the Battery .............................................6-3
Battery Removal Process ....................................6-3
Upgrading the Hard Disk Drive ..............................6-4
Hard Disk Upgrade Process ................................6-4
Upgrading the System Memory (RAM) ..................6-6
Memory Upgrade Process ......................................6-6
Upgrading the Processor ........................................6-8

Troubleshooting
Overview ..............................................................7-1
Basic Hints and Tips ................................................7-2
Backup and General Maintenance ............................7-3
Viruses ..................................................................7-4
Upgrading and Adding New Hardware/Software ....7-5
Power .................................................................7-7
Display .................................................................7-9
Boot Password ......................................................7-10
Audio .................................................................7-11
Preface

CD Device (Optional) ............................................ 7-12
Keyboard and Mouse ............................................. 7-13
Operation .............................................................. 7-14

Advanced Power Saving
Power Schemes & Processor Performance .......... A-2
Intel CPU SpeedStep Controls ......................... A-3

Model A Specifications
Processor Types ....................................................... B-1
Core Logic ............................................................... B-1
Security ................................................................. B-1
Memory ................................................................. B-1
BIOS ........................................................................ B-1
LCD ......................................................................... B-1
Display ..................................................................... B-2
Storage ..................................................................... B-2
Audio ....................................................................... B-2
Keyboard, Pointing Device & Buttons .................... B-2
Indicators ................................................................. B-2
Interface & Communication .................................... B-3
Power Management ................................................. B-3
Power ....................................................................... B-3
Environmental Spec ................................................. B-3
Physical Dimensions & Weight ............................. B-3
Optional ................................................................... B-4

Model B Specifications
Processor Types ....................................................... C-1
Core Logic ............................................................... C-1
Security ................................................................. C-1
Memory ................................................................. C-1
BIOS ........................................................................ C-1
LCD ......................................................................... C-1
Display ..................................................................... C-2
Storage ..................................................................... C-2
Audio ....................................................................... C-2
Keyboard, Pointing Device & Buttons .................... C-2
Indicators ................................................................. C-2
Interface & Communication .................................... C-3
Power Management ................................................. C-3
Power ....................................................................... C-3
Environmental Spec ................................................. C-3
Physical Dimensions & Weight ............................. C-3
Optional ................................................................... C-4
Chapter 1: Introduction

Overview
This manual refers to the hardware and essential software required to run your computer. Depending on how your system is configured, some or all of the features described may already be set up. This chapter covers:

• The Manual — how to use it
• System Map — navigating around your computer

Advanced Users
If you are an advanced user you may skip over most of this manual. However you may find it useful to refer to “What to Install” on page 4 - 2, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1. You may find the notes marked with a of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then you should try to look through all the documentation. Do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a as indicated in the margin.
Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the symbol. Also please note the safety and handling instructions as indicated in the Preface.

Not Included
Operating Systems (e.g. Windows XP etc.) have their own manuals, as do applications (e.g. word processing, spreadsheet and database programs). If you have questions about the operating systems or programs then please consult the appropriate manuals.

System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find this manual refers to the following operating systems:

- Windows 2000 (with Service Pack 4 included)
- Microsoft Windows XP Professional & Home Editions
Quick Start Guide

This guide assumes that you are already familiar with computers and can tell at a glance what and where all the key components are. If you are not that comfortable with this type of device, then please refer to the following pages, which give an overview of the system.

It is still best to review these steps, before taking any action. If there is anything you are not sure about, then please refer to the appropriate chapter before continuing.

Unless you need to install an operating system, your computer should be ready to work right out of the box. Before you begin please follow the safety instructions in the Preface.

1. Remove all packing materials.
2. Securely attach any peripherals you want to use with the computer (e.g. keyboard and mouse) to their ports.
3. Attach the AC adapter to the DC-in jack at the rear of the computer (see "Rear View" on page 1 - 19), then plug the AC power cord into an outlet, and connect the AC power cord to the AC adapter.
4. Raise the LCD Swivel Screen to a comfortable viewing angle.
5. Press the power button to turn “On”.

Peripheral Devices

Please note that peripherals (printers, digital cameras, etc.) which attach to your computer by USB ports may be connected after Windows is up and running. All other peripherals must be connected before you turn on the system.
System Map
Your computer has a lot of built-in features. Most of these are enabled by your operating system. Further explanations of the various subsystems are covered in the chapter or pages indicated.

Model Differences
This notebook series includes two different model types. Model A includes a Touch Panel screen, Model B does not. The specifications for each model are listed in “Model A Specifications” on page B - 1 and “Model B Specifications” on page C - 1.

In addition both Model A and Model B have two different designs as pictured on the following page.
Getting to Know Your Computer
The following graphics will help you to become familiar with the basic functions, and to learn the location of the various ports and components of your computer.
To open the LCD display:
1. Place the computer on a stable surface.
2. Press the latches in the direction of the arrows ① (press in) to release the top cover.
3. Lift the top cover to reveal the LCD Swivel Screen and keyboard.
4. Adjust the LCD Swivel Screen to a comfortable viewing angle.
5. The LED indicators ② show the power and battery status of the computer.
6. If you wish to operate the computer in Tablet Mode see page 1 - 7.
The LCD Swivel Screen

You can use the computer either in Notebook Mode, or in Tablet Mode. To put the computer into Tablet Mode:

1. Unlock the LCD side hinges 1 & 2 by moving them in the direction of the arrows.
2. Carefully rotate the LCD fully in the direction indicated by the arrow 3, then lock the side hinges 1 & 2.
3. Move latches 4 & 5 in and to the left (if they are not already in this position), then push the LCD down to lock it in position.

Figure 1 - 3
Rotating the LCD Swivel Screen
Introduction

*Figure 1 - 4*
Top View with LCD Panel Open

1. Built-In PC Camera (Optional)
2. LCD Swivel Screen
3. LED Power Indicators
4. Cover Sensors
5. LCD Swivel Hinge
6. LCD Side Hinges
7. Power Button
8. Speakers
9. Keyboard
10. TouchPad and Buttons
11. Built-In Microphone

1 - 8 Top View with LCD Open
PC Camera
If you have purchased the optional PC Camera, make sure you install the software application (see pages 4 - 12, 4 - 19 & 3 - 26).

LCD Swivel Screen
The computer comes with a TFT (Thin Film Transistor), Liquid Crystal Display screen (see “LCD” on page B - 1/“LCD” on page C - 1 for details). The screen can rotate and tilt for best visibility in Notebook Mode, and flip for use in Tablet Mode. The screen may be rotated as long as the driver is installed (see “What to Install” on page 4 - 2) to appear in Landscape Mode or Portrait Mode by means of the VGA Rotate Application or “Q” Hot-Key (see “Screen Rotation” on page 3 - 4).

The screen also acts as a Touch Panel (Model A only) when the driver is installed (see pages 4 - 13 & 4 - 20). You can use the stylus pen provided to point directly to objects on the screen in much the same way as you would use your mouse as the pointing device (see “Touch Panel (Model A Only)” on page 2 - 19).

LED Power Indicators
These indicators display the system power status, and battery status of the computer (see “LED Power Indicators” on page 2 - 5).
Cover Sensors

These switches act as sensors to tell when the LCD Swivel Panel is closed, in Notebook Mode, or in Tablet Mode.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Left LCD Cover Sensor</th>
<th>Right LCD Cover Sensor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notebook Mode (LCD Open)</td>
<td>Press the left LCD cover sensor to trigger the default power saving state (“When I close the lid of my portable computer”).</td>
<td>Press and hold the right LCD cover sensor, and simultaneously press/tap the “Q” key to trigger the functions as per “Q Key Functions” on page 2 - 16.</td>
</tr>
<tr>
<td>Notebook Mode (LCD Closed)</td>
<td>Close the LCD to automatically trigger the default power saving state (“When I close the lid of my portable computer”).</td>
<td>N/A</td>
</tr>
<tr>
<td>Tablet Mode</td>
<td>N/A</td>
<td>If the LCD is fully locked down, the right LCD cover sensor will be depressed automatically. Press/tap the “Q” key to trigger the functions as per “Q Key Functions” on page 2 - 16.</td>
</tr>
</tbody>
</table>

See **Lid** in *Figure 3 - 14 on page 3 - 23* for information on setting the power saving state. See the sidebar for the power scheme setting recommendation.
LCD Swivel & Side Hinges
Release the side hinges in the direction indicated by the arrows on the top panel, and swivel the LCD panel in the direction indicated on the top panel.

Power Button
Press this button to turn your computer On or Off (see “Turning on the Computer” on page 2 - 4). This button may also be used as a suspend/resume key, once configured as such in the power management control panel of your operating system (see “Configuring the Power Button” on page 3 - 23).

Stereo Speakers
Two built-in speakers provide rich, stereo sound.

Shutdown
Please note that you should always shut your computer down by choosing the Shut Down/Turn Off Computer command from the Start menu in Windows. This will help prevent hard disk or system problems.

Forced Off
If the system "hangs", and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.
Keyboard
The computer has a “Win Key” keyboard including an embedded numeric keypad. It has the same features as a full-sized desktop keyboard and can easily be replaced with a different language keyboard should you desire.

TouchPad & Buttons
The pointing device features a sensitive glide pad for precise movements. It functions the same way as a two-button mouse. The right TouchPad button is the same as the right mouse button; the left TouchPad button is the same as the left mouse button (see “TouchPad and Buttons/Mouse” on page 2 - 25).

Microphone
Record on your computer with the built-in microphone.
**Front View**

1. **LCD Latches**
   Press the LCD latches in to release the LCD panel (see page 1 - 6).

2. **Microphone-In Jack**
   Record on your computer with an external microphone (the microphone-in jack is colored pink).

---

**Infrared Communication**

The Infrared transceiver operates on a “Line of Sight”. Make sure nothing is blocking the “Line of Sight” between your system’s transceiver and the destination’s transceiver.
1 - 14 Front View

**Headphone-Out Jack**
Headphones may be connected through this jack (the headphone-out jack is colored green). **Note**: Set your system’s volume to a reduced level before connecting to this jack.

**Infrared Transceiver**
The infrared transceiver enables communication between the computer and another similarly equipped device, and is 4M bps FIR, IrDA 1.1 compliant. See “Configuring the Infrared Transceiver” on page 2 - 26 for further information, and also refer to the manual of the device you wish to connect.

**Scroll/Enter Wheel**
The wheel key works as a scrolling key (in much the same way as the keyboard arrow keys) if moved to the left or right. If you push the key in it will act as an Enter/Return key.

**LED Status Indicators**
These display the system’s operational status. Refer to “LED Power Indicators” on page 2 - 5 for more information on what the lights mean.
Hot-Key Buttons

The three Hot-Key buttons include **Tab & Esc** keys (these keys are particularly useful in Tablet Mode), and a “Q” key (which also acts as a **power button**) to rotate the screen between Portrait and Landscape modes (see “Q Key Functions” on page 2 - 16 for full details).

---

Playing DVD’s/VCD’s and Screen Rotation

If you are playing a DVD/VCD video, **do not rotate the screen while playing the video.** If you wish to rotate the screen quit the player program first, rotate the screen, then open the player to play the video.
Introduction

Figure 1 - 6
Left Side View

1. Security Lock Slot
2. Vent
3. Stylus Pen Holder

Security Lock Slot
To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.

Vent
This enables airflow to prevent the computer from overheating.

Stylus Pen Holder
Keep the stylus pen in this holder when not in use.

Overheating
To prevent your computer from overheating make sure nothing blocks the vent/fan intake while the computer is in use.
Right Side View

4-in-1 Flash Card Reader
The card reader allows you to use four of the most popular digital storage cards. See “4-in-1 Card Reader” on page 2 - 14 and note the driver installation information in the sidebar. The formats that can be read include:

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- SM (SmartMedia Card)

External CD Devices
External CD devices (e.g. CD-ROM drives, DVD-ROM drives, CD-RW drives and Combination drives) may be plugged in to either of the USB ports.

Figure 1 - 7
Right Side View
1. 4-in-1 Flash Card Reader
2. Two USB 2.0 Ports
3. PC Card Slot

Flash Card Reader Driver
Make sure you install the ENE-PCMCIA driver as this includes support for the Card Reader (see “What to Install” on page 4 - 2).
Introduction

Two USB 2.0 Ports
These **USB 2.0** compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external DVD devices, CD devices, HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).

PC Card Slot
The 3.3V/5V slot may be used for a Type-II PC Card (PC Cards were also previously referred to as PCMCIA) and fully supports Cardbus. Refer to “**PC Card Slot**” on page 2 - 15 for more information.
Introduction

Rear View

External Monitor (VGA) Port
Connect an external monitor to this port to allow dual video or simultaneous display on the LCD and external monitor (see “Display Devices” on page 3 - 11).

RJ-45 LAN Jack
This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Overheating
To prevent your computer from overheating make sure nothing blocks the vent/fan intake while the computer is in use.

Figure 1 - 8
Rear View
1. External Monitor (VGA) Port
2. RJ-45 LAN Jack
3. RJ-11 Phone Jack
4. DC-In Jack
5. Vent
**Introduction**

**RJ-11 Phone Jack**
This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11 telephone connection.
*Note:* Broadband (e.g. ADSL) modems usually connect to the LAN port.

**DC-In Jack**
Plug the supplied AC adapter into this jack to power your computer.

**Vent**
This enables airflow to prevent the computer from overheating.
Bottom View

Stylus Pen Holder
The stylus pen fits in this holder.

Battery
See “Battery Information” on page 3 - 24 for information on battery use and care.

Figure 1 - 9
Bottom View
1. Stylus Pen Holder
2. Battery
3. Wireless LAN Module Cover
4. Hard Disk Cover
5. RAM Cover
6. CPU Cover
7. Vent

Overheating
To prevent your computer from overheating make sure nothing blocks the vent/fan intake while the computer is in use.

CPU
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
Wireless LAN (Network) Module
The computer’s 802.11b Wireless LAN module, and its antenna and other components, are not externally visible (please check with your service representative). Make sure you install the driver (see pages 4 - 11 & 4 - 17). Make sure the wireless module is OFF when you are using the computer aboard aircraft (see sidebar note).

Hard Disk Drive
The internal hard disk drive is used to store your data. See page 6 - 4 for information on upgrading/replacing your hard disk drive.

Drive Warning
Don’t try to remove the hard disk (HDD) while the system is on. This could cause data loss or damage. Unauthorized removal or tampering with the HDD may violate your warranty. If you are in doubt, consult your service representative.

Vent
This enables airflow to prevent the computer from overheating.
Chapter 2: Using The Computer

Overview
To learn more about using your computer, please read this chapter.

This chapter includes:

• The Power Sources
• Turning on the Computer
• The LED Indicators
• The Hard Disk Drive
• The Floppy Disk Drive (Optional)
• CD/DVD Device (Optional)
• 4-in-1 Card Reader
• The PC Card Slot
• The Hot-Keys
• The Keyboard
• The Touch Panel
• Handwriting Application (Optional)
• The TouchPad & Buttons/Mouse
• Configuring the Infrared Settings
• Adding a Printer (General Guidelines)
The computer can be powered by either an AC adapter or a battery pack.

**AC Adapter**

Use only the AC adapter that comes with your computer. The wrong type of AC adapter will damage the computer and its components.

1. Attach the AC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC adapter.
3. Raise the LCD Swivel Panel to a comfortable viewing angle.
4. Press the power button to turn “On”.

Fully ACPI-compliant OS’s such as Windows XP/2000 can use the “Power Options” control panel to set the power button to send the system into Standby or Hibernate mode (see your OS’s documentation, or “Configuring the Power Button” on page 3-23 for details).
Battery
The battery allows you to use your computer while you are on the road or an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging.

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 24.

Recharging the Battery with the AC Adapter
The battery pack automatically recharges when the AC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 2 - 5 for information on the battery charge status, and to “Battery Information” on page 3 - 24 for more information on how to maintain the battery pack.)

Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Low Battery Warning
When the battery is critically low, immediately connect the AC adapter to the computer or save your work, otherwise, the unsaved data will be lost when the power is depleted.
Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Standby/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options in the Windows control panel to configure this feature.

If the computer is in Tablet Mode you can use the “Q” Hot-Key as a power button (see “Q Key Functions” on page 2 - 16 for full details).
LED Indicators

There are two sets of LED indicators (LED Power Indicators and LED Status Indicators) on your computer that will display helpful information about the current status of the computer. The LED Power Indicators are also visible when the top of your computer is closed (in Notebook Mode).

**LED Power Indicators**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Orange" /></td>
<td>Orange</td>
<td>The AC Adapter is plugged in</td>
</tr>
<tr>
<td><img src="image" alt="Green" /></td>
<td>Green</td>
<td>The computer is on</td>
</tr>
<tr>
<td><img src="image" alt="Blinking Green" /></td>
<td>Blinking Green</td>
<td>The computer is in standby mode</td>
</tr>
<tr>
<td><img src="image" alt="Orange" /></td>
<td>Orange</td>
<td>The battery is being charged</td>
</tr>
<tr>
<td><img src="image" alt="Green" /></td>
<td>Green</td>
<td>The battery is fully charged</td>
</tr>
<tr>
<td><img src="image" alt="Blinking Orange" /></td>
<td>Blinking Orange</td>
<td>The battery has reached critically low power status</td>
</tr>
</tbody>
</table>

*Table 2-1 LED Power Indicators*
Using The Computer

### LED Status Indicators

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📡</td>
<td>Green</td>
<td>The WLAN Module is On</td>
</tr>
<tr>
<td>🗄</td>
<td>Green</td>
<td>Hard Disk/System activity</td>
</tr>
<tr>
<td>🔒</td>
<td>Green</td>
<td>Number Lock is activated</td>
</tr>
<tr>
<td>🔒</td>
<td>Green</td>
<td>Caps Lock is activated</td>
</tr>
<tr>
<td>🔄</td>
<td>Green</td>
<td>Scroll Lock is activated (to activate press Fn &amp; ScrLk)</td>
</tr>
</tbody>
</table>
Hard Disk Drive

The hard disk drive is used to store your data in the computer. The hard disk can be taken out to accommodate other 2.5" IDE hard disk drives with a height of 9.5 mm.

The hard disk is accessible from the bottom of your computer as seen below. Further details on removing and inserting the hard disk are available in “Upgrading the Hard Disk Drive” on page 6 - 4.

![Hard Disk Location](image)

**Power Safety**

Before attempting to access any of the internal components of your computer please ensure that the machine is not connected to the AC power, and that the machine is turned off. Also ensure that all peripheral cables, including phone lines, are disconnected from the computer.
The Floppy Disk Drive (Optional)

The **optional** external 1.44 MB, 3.5" USB floppy disk drive can connect to any of the USB ports on the computer. By default it is drive “A:” and can be used as a boot device if properly set in the BIOS (refer to “Boot Device (Startup Menu)” on page 5 - 9). If your purchase configuration does not include this option you can purchase a USB floppy disk drive from a computer store.

**Inserting/Removing Floppy Disks**

When using the floppy drive, always insert your floppy diskette with the label-side facing up. To remove the inserted diskette, press the eject button on the top-right corner of the floppy drive.

**Media Warning**

Don’t try to remove a floppy disk while the system is accessing it. This may cause the computer to “crash” and damage your data.
CD Device/DVD Device (Optional)

The optional external CD/DVD Device is USB 2.0 compliant and can connect to any of the USB ports on the computer. If your purchase configuration does not include this option you can purchase a USB CD/DVD Device from a computer store.

When used with your computer the device must be powered by an AC power source via the AC adapter. When used with the AC adapter make sure the power switch is set to EXT (external power).
Using The Computer

Optional CD/DVD Device Options

The optional external CD device is available in CD-ROM, or DVD-ROM, or CD-RW, or Combination CD-RW and DVD-ROM drive configurations. The CD Device is usually labeled “Drive D:”, and may be used as a boot device if properly set in the BIOS (“Boot Device (Startup Menu)” on page 5 - 9).

Playing Audio CD’s in Windows 2000

To play audio CD’s in an external USB CD Device, follow this procedure:

Go to Device Manager (see step 1 of the Touch Panel driver installation instructions on page 4 - 13) and click “+” next to DVD/CD-ROM Drives. Double-click the device and select the Properties tab. Make sure there is a tick in the “Enable digital CD audio for this CD-ROM device.”

Figure 2 - 3
Enable CD Audio

Enable CD Audio for Windows 2000 USB CD Device
Loading CDs or DVDs
To insert a CD/DVD, press the eject button and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The LED indicator will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency tray release hole to open the tray.

Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CD-ROMs/DVD-ROMs can be accessed. Remember to:

- Hold the CD or DVD by the edges; do not touch the surface of the disc.
- Use a clean, soft, dry cloth to remove dust or fingerprints.
- Do not write on the surface with a pen.
- Do not attach paper or other materials to the surface of the disc.
- Do not store or place the CD or DVD in high-temperature areas.
- Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
- Do not bend the CD or DVD.
- Do not drop or subject the CD or DVD to shock.
Using The Computer

**DVD Regional Codes**

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module with another computer.

![Figure 2 - 4 DVD Regional Codes (Windows XP)](image-url)
Changing DVD Regional Codes

Go to the Control Panel in Windows XP/Windows 2000 and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties menu, and select the DVD Region (tab) to bring up the control panel as seen in “DVD Regional Codes (Windows XP)” on page 2 - 12.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

*Table 2 - 3 DVD Regional Coding*
4-in-1 Card Reader

The 4-in-1 Card Reader allows you to use four of the most popular digital storage cards. Make sure you install the ENE-PCMCIA driver as this includes support for the Card Reader (see “What to Install” on page 4 - 2).

To read from the card, simply insert the card into the slot and it will appear as a removable device. Formats that can be read include:

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- SM (SmartMedia Card)
PC Card Slot

The computer is equipped with a PCMCIA 3.3V/5V slot for one type II PC Card. Make sure you install the driver for the PC Card (see “What to Install” on page 4 - 2).

Inserting and Removing PC Cards
- Align the PC Card with the slot and push it in until it locks into place.
- To remove a PC Card, simply press the eject button next to the slot.

Conserving Battery Power
To conserve battery power remove any unused PC Cards from the computer (PC Cards quickly use up battery power even if the system enters sleep mode).

Figure 2 - 6
PC Card Slot
**Using The Computer**

**Hot-Keys**

The four Hot-Key buttons include Tab & Esc keys (these keys are particularly useful in Tablet Mode) and a wheel key for scrolling/Enter key functionality. (Move the wheel left or right for scrolling functions in much the same way as the keyboard arrow keys; push the wheel in for Enter/Return functions.) In **Tablet Mode** the “Q” key is used to toggle the screen rotation between Landscape and Portrait configurations; it also acts as a power button. The table below lists the function options depending upon the time duration the key is pressed (see sidebar for use in Notebook mode).

<table>
<thead>
<tr>
<th>Power State</th>
<th>“Q” key function</th>
<th>Time Pressed</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Rotate Screen</td>
<td>Tap (do not press) for less than 0.8 seconds</td>
</tr>
<tr>
<td>On</td>
<td>Initiates the default setting of OS’s power scheme (<strong>Power Button</strong>) - “When I press the power button on my portable computer” - (see <strong>Figure 3 - 14 on page 3 - 23</strong>)</td>
<td>More than 0.8 seconds but less than 4 seconds</td>
</tr>
<tr>
<td>On</td>
<td>System Shutdown</td>
<td>More than 4 seconds</td>
</tr>
<tr>
<td>Off</td>
<td>System Power On</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Table 2 - 4**

**Q Key Functions**

---

**Right Cover Sensor**

The right LCD cover sensor (see “Cover Sensors” on page 1 - 10) is used in conjunction with the “Q” Hot-Key to tell the computer when it is in **Tablet mode** (when the computer is in Tablet mode the right cover sensor is depressed).

If you are in **Notebook mode** you can perform the same set of functions listed in the table by tapping/pressing the “Q” key and pressing the right cover sensor simultaneously.
The Keyboard

The Function Keys

On the bottom-left of the keyboard is the **Fn** key, or Function key, which allows you to change operational features instantly. To use the functions press and hold the **Fn** key, and then press the appropriate function key (F3 - F11 etc.) located on your keyboard.

<table>
<thead>
<tr>
<th>Function Keys</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep Toggle</td>
</tr>
<tr>
<td>Fn + F5</td>
<td>Decrease Audio Volume</td>
</tr>
<tr>
<td>Fn + F6</td>
<td>Increase Audio Volume</td>
</tr>
<tr>
<td>Fn + F7</td>
<td>Display Toggle</td>
</tr>
<tr>
<td>Fn + F8</td>
<td>Decrease LCD Brightness</td>
</tr>
<tr>
<td>Fn + F9</td>
<td>Increase LCD Brightness</td>
</tr>
<tr>
<td>Fn + F11</td>
<td>Wireless LAN Module On/Off Toggle</td>
</tr>
</tbody>
</table>

**Wireless Device Operation Aboard Aircraft**

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module is **OFF** if you are using the computer aboard aircraft. When your computer ‘Boots Up’ the module will be **ON**. To toggle power to the WLAN module use the key combination **Fn + F11**, or the “**VGA Rotate Application**” on page 3 - 4.

**Table 2 - 5**

Function Keys

**Other Keyboards**

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not work.
Using The Computer

2

Special Characters
Some software applications allow the number-keys to be used with Alt to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that Num Lock is on.

2 - 18 The Keyboard

Numeric Keypad
The keyboard has an embedded numerical keypad for easy numeric data input. Activate the Number Lock feature by pressing the Fn and Num Lk key combination. You may check if Number Lock is enabled or not by looking at the LED status indicators (see “LED Indicators” on page 2 - 5). To type a number from the numeric keypad make sure Num Lk is enabled, and then press the key on the numeric keypad. (To type a letter from the numeric keypad if Num Lk is enabled, hold down the Fn key and press the appropriate letter key.)

Activate Scroll Lock by pressing the Fn and Scr Lk key combination.

Figure 2 - 7
Keyboard
Touch Panel (Model A Only)

If your computer is Model A the LCD screen also acts as a Touch Panel when the driver is installed (see pages 4 - 13 & 4 - 20). Use the stylus pen provided to point directly to objects on the screen in much the same way as you would use your mouse as the pointing device.

A new icon (  or ) will appear in the taskbar (if you do not see the icon go to the Touch Panel control panel and click the tickbox to display the icon in the taskbar - see Figure 2 - 9) after you install the Touch Panel driver. Click this icon to switch your provided stylus pen to act as a left or right mouse button. The Touch Panel control panel allows you to configure the input options from the Touch Panel Set-Up and Configuration Utility (see over for screen examples). Make sure you calibrate the Touch Panel.

Figure 2 - 9
Touch Panel Control Panel

Touch Panel Input Device
(Model A Only)

Do not use any sharp or pointed objects as your input device e.g. the end of a pen or pencil. You should only use the provided stylus pen (PDA type) as your input device.

Pay particular attention to the area at the edge of the screen where the LCD meets the frame (see page 2 - 21).
Using The Computer

Touch Panel Calibration

Make sure you calibrate the Touch Panel from the Touch Panel Set-Up and Configuration Utility.

1. Click the Calibration tab.
2. Click the Calibrate Now button.
3. Use the input device to touch the cross at the different positions on screen.
4. Click the Update button.

Figure 2 - 9

Touch Panel Set-Up and Configuration Utility
Do not use any sharp or pointed objects as your input device e.g. the end of a pen or pencil. You should only use the provided stylus pen (PDA type) as your input device.

Figure 2 - 10
Touch Panel Warning

Do Not Slide the Stylus Pen (or any object) Around the Edge of the LCD Screen
Handwriting Application (Optional)

If your purchase includes the handwriting application you may write on the screen of your computer, and convert this into text to be entered into any *Windows* application. The application contains the *ritePen* and *riteMail* utilities. To install the utilities follow this procedure:

**ritePen Installation**
1. Insert the *RiteNotes HandWriter* CD into an external CD/DVD device.
2. Click *Start* (menu) > *Run*...
3. Navigate (*Browse..*) to `D:\ritePen\Setup.exe` and click *OK*.
4. Click *Next > Yes*.
5. Input a *User Name* and *Company Name* (you are required to input something into both fields), and then click *Next > Next > Next > Next*.
6. Click *Finish*.

**riteMail Installation**
1. Insert the *RiteNotes HandWriter* CD into an external CD/DVD device.
2. Click *Start* (menu) > *Run*...
3. Navigate (*Browse..*) to `D:\riteMail\riteMailWinClient.v.2.0.45.cv.exe` and click *OK*.
4. Click *Next > Yes*.
5. Input a *User Name* and *Company Name* (you are required to input something into both fields), and then click *Next > Next > Next*.
6. Click *Finish*.

---

**ritePen**
The *ritePen* program is a handwriting recognition application which allows you to use the provided PDA stylus pen to write text on the screen. The handwriting will then be converted into text for use in any application.

**riteMail**
The *riteMail* program is a note-taking and editing application which allows you to export the notes to applications e.g as a handwritten email.
ritePen

If you do not see the ritePen notification icon in the taskbar you can open the utility by going to the Start menu and pointing to Programs/All Programs > Parascript > ritePen, and clicking ritePen. The icon will appear in the taskbar to indicate it is active. Use the input device to click the icon to make the utility inactive (the icon will change to ).

When the notification icon is enabled you may enter text into any active (make sure the application is in the foreground) text-enabled application by using your input device to write on the screen. The written text will be input into the active screen window when you complete writing.

Figure 2-11
Text Input

Help
Full instructions for both the ritePen and riteMail utilities (ritePen Help & riteMail Help) are available from the Parascript item in the Programs/All Programs menu.
riteMail
Run the riteMail program from the Start menu and pointing to Programs/All Programs > Parascript > ritePen, and clicking riteMail. You can use the input device to write in the note taking area of the utility, and then select it by using the Selector to circle, cross or click the required area (hold the shift key down to select additional area or choose Select All from the Edit menu).

The selected area may be exported as a picture, or may be converted to text. To export the selected electronic ink, just copy and paste it into your application. To export the selected electronic ink as text, select Copy as Text from the Edit menu (click OK after the program completes the text recognition) that can then be pasted into your application.

Figure 2 - 12
riteMail Message
TouchPad and Buttons/Mouse

The TouchPad is a device for pointing (controlling input positioning) on the computer’s display screen by sensing finger movement, and downward pressure. It is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports.

The TouchPad buttons function in much the same way as a two-button mouse. Once you have installed the TouchPad drivers (see pages 4 - 10 & 4 - 16) you can configure the functions by double-clicking the TouchPad driver icon on the taskbar. You will find further information at www.synaptics.com.

Mouse Driver

If you are using an external mouse your operating system may be able to auto-configure your mouse during its installation or only enable its basic functions. Be sure to check the device’s user documentation for details.

Figure 2 - 13
Mouse Properties
Configuring the Infrared Transceiver

To configure the computer’s settings for Fast Infrared (FIR) communication follow these steps:

1. Click **Start**, point to **Settings** (or just click **Start** and click **Control Panel**) and click **Control Panel**.
2. Double-click **Wireless Link** (in the **Printers and Other Hardware Category**) icon.
3. Click **Hardware** (tab), and then click **Properties** (button).
4. Select **Advanced** (tab).
5. Select “**Infrared Transceiver A**” and change the **Value** to “**IBM 31T1100**”.
6. Click **OK > OK**.

The settings for the infrared transceiver may also be configured in the **BIOS** (see “**COM Ports (Components Menu)**” on page 5 - 13).

For further information, please refer to the manual of the device you wish to connect.
Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer, however it is always best to refer to the printer manual for specific instructions and configuration options.

USB Printer

Most new printers have a USB interface connection. You may use any of the USB ports on your computer to connect the printer.

Install Instructions:

1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.
Parallel Printer
This is still a very common type of printer. A Parallel to USB converter may be purchased at most computer stores.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Attach the parallel cable to the printer.
3. Connect the printer’s parallel cable to the Parallel to USB converter, and then plug the converter into the USB port.
4. Turn ON the printer.
5. Turn ON the computer.
6. Windows (some operating systems may require a driver to recognize the parallel to USB adapter) will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.
Chapter 3: Advanced Controls

Overview

This chapter covers:

• Advanced Video Controls
• Power and Battery Management Features
• PC Camera Module (optional)
• Wireless LAN Module (optional)

Note: All operating system pictures in this manual are from the Microsoft Windows XP OS.
Advanced Video Controls

This section is about making adjustments for the LCD, and switching display devices.

Opening the LCD
As you open the lid, adjust it so you can look at the screen straight on, without any glare. If necessary, adjust the brightness controls (Fn + F8/F9). The Fn + F7 key combination allows you to toggle through display options if you have a monitor attached (see “Function Key Combinations” on page 3 - 13).

Protecting the LCD
Do not allow any foreign objects (i.e. paper or plastic) to get between the lid/LCD and the work panel. They could damage or scratch the LCD and/or accidentally activate the close cover switch.

Figure 3 - 1
Display Controls
Video Memory

The computer does not have dedicated video memory. The video memory available on your computer is configured in two modes of operation.

**VGA Shared Memory**
This is the pre-allocated memory size for VGA compatibility. This is fixed in the BIOS at 32MB (see page 5 - 11). This memory is allocated from your system memory e.g. if you computer has 256MB of memory (RAM), then 32MB will be allocated to video leaving the system with 224MB of RAM.

**Dynamic Video Memory Technology**
Intel® DVMT automatically and dynamically allocates as much (up to 64MB) system memory (RAM) as needed to the video system (the video driver must be installed - see “What to Install” on page 4 - 2). DVMT returns whatever memory is no longer needed to the operating system.

<table>
<thead>
<tr>
<th>System Memory</th>
<th>Maximum Memory Allocated for Graphics by DVMT</th>
</tr>
</thead>
<tbody>
<tr>
<td>0MB - 127MB</td>
<td>Not Supported</td>
</tr>
<tr>
<td>128 MB - 255MB</td>
<td>32MB</td>
</tr>
<tr>
<td>256MB - Maximum Memory</td>
<td>64MB</td>
</tr>
</tbody>
</table>

Table 3 - 1
DVMT Memory Requirements
Advanced Controls

Screen Rotation

The screen may be rotated to appear in Landscape Mode or Portrait Mode by means of the screen rotation driver or “Q” Hot-Key (see “Hot-Keys” on page 2 - 16). Make sure the screen rotation driver is installed before attempting to rotate the screen (see the driver installation procedure on pages 4 - 13 & 4 - 19).

VGA Rotate Application

Double-click the icon in the taskbar to bring up the screen rotation menu. Click a button to rotate the screen, or hide the application. You can also use the buttons to toggle power On/Off to the WLAN module, send the computer in to a power saving mode (the same mode as set for the “Sleep Button” on page 3 - 23), or to adjust the brightness of the screen.

Uncheck this box to prevent screen rotation problems in Windows 2000.

Playing DVD’s/VCD’s and Screen Rotation

If you are playing a DVD/VCD video, do not rotate the screen while playing the video. If you wish to rotate the screen, quit the player program first, rotate the screen, then open the player to play the video.

Figure 3 - 2
VGA Rotate Application
“Q” Hot-Key

In Tablet Mode the “Q” key is used to toggle the screen rotation between Landscape and Portrait configurations; it also acts as a power button. Make sure you gently tap the “Q” key to get the screen to rotate (do not press the key for too long or it will initiate a power saving mode). See “Q Key Functions” on page 2 - 16 for full details on the “Q” key functions.

Screen Rotation in Windows 2000

To prevent errors in rotating the screen to 90 or 180 degrees in Windows 2000, follow this procedure.

Go to the Display Properties (see Figure 3 - 3 on page 3 - 7 Window.

Click Advanced (button) and click Monitor (Tab).

Uncheck the box “Hide modes that this monitor cannot display.” (see Figure 3 - 2 on page 3 - 4).

Click OK and close the open Windows.
Video Driver Controls

The video interface lets you change the screen resolution and color output to whatever is most comfortable/efficient for you. This is a matter of hardware, video memory and the driver for your operating system. The driver interface shows the available options (see pages B - 1 & C - 1 for LCD information).

You can switch display devices from the Display Properties control panel in Windows as long as the video driver is installed (see “What to Install” on page 4 - 2).

Making Adjustments for the Display

The higher the resolution you set the LCD for, the more information the LCD can display on screen. To change the LCD’s resolution and color depth go to the Display Properties control panel:

1. Click Start, point to Settings (or just click Control Panel) and click Control Panel (if you are in Category View choose Appearance and Themes).
2. Double-click Display (icon).
3. In the Display Properties dialog box, click Settings (tab).
4. In Screen area/Screen resolution, move the slider to the preferred setting for resolution (see 1 in Figure 3 - 3 on page 3-7).
5. In Colors/Color quality, click the arrow and scroll to the preferred setting for color depth (see 2 in Figure 3 - 3 on page 3-7).
When the **Display Properties** control panel is open, click the **Advanced** button to bring up the options tabs. Clicking through these tabs allows you to make any video adjustments you require.
Advanced Controls

Intel Video Driver Controls

After installing the video driver there will be an additional control panel entitled Intel(R) Extreme Graphics 2 M. To get to the control panel to make changes to the Graphics Properties, do the following:

1. Click Start, point to Settings (or just click Control Panel) and click Control Panel.
2. Double-click Intel(R) Extreme Graphics 2 M (icon) to bring up the Intel(R) 82852/82855 GM/GME Graphics Controller Properties.

Taskbar
You may also access the control panel from the taskbar at the bottom right of the screen. Click on the icon to bring up the menu and scroll to Graphics Options > Graphics Properties.

If you cannot see the tray icon go to the Intel(R) Extreme Graphics 2 for Mobile tab (in the Advanced options) and click the “Show Tray Icon” tick-box.

Figure 3 - 4
Intel Extreme Graphics Control Panel

3 - 8 Video Driver Controls
You may make changes to the Devices, Color, and Schemes by clicking the appropriate tab and adjusting the setting, then clicking OK. The Information and Open GL tabs display useful information about the graphics properties of your computer, and the Support item in the Information tab has web links to the latest information (drivers, troubleshooting issues etc.) on the Intel Website. Screen examples are shown on the following page.

Figure 3 - 5
Intel Graphics Controller Properties
Schemes

Use Schemes to configure quick settings for applications that require specific resolution and color settings in order to run properly e.g. games, multimedia programs. To set the schemes:

1. Go to the Intel(R) Extreme Graphics 2 M control panel (see “Intel Video Driver Controls” on page 3 - 8).
2. Click on Schemes (tab).
3. Select New to setup the scheme, and type a name in the dialog box that pops up, then click OK.
4. Click on the scheme name you had typed in the Schemes box, and choose the option you wish to use from the Video Modes box.
5. Browse to the executable file for the application you want to set a scheme for (see sidebar).
6. You can click in the "Reset On Exit" box to return to your original settings when you exit the program, then click Save to save the settings.
7. When you want to run the program, select it from the Schemes box and click "Invoke" to run the highlighted program in the chosen video setting (alternatively you can select it from Display Modes by clicking on the icon option in the taskbar at the bottom right of the screen).

Application.exe

You will need to locate the actual application executable (.exe) file, not just the shortcut. To find the application right-click its shortcut on the desktop click Properties. Click the Shortcut (tab) and see where the executable file is located by clicking the Find Target (button). Note the location and you will then be able to browse to this file.
Display Devices

Besides the built-in LCD, you can also use an **external monitor** as your display device. A monitor connects to the external monitor (VGA) port.

**Switching/Enabling Displays (Keyboard)**

You can switch display devices with the \texttt{Fn + Display (F7)} toggle. With the \texttt{video driver installed}, you also can use its built-in controls to switch the display options. If you haven’t installed the video driver, refer to “\textit{What to Install}” on page 4 - 2 for setup instructions. To switch the display options:

1. Plug the monitor into the appropriate port.
2. Press and hold the \texttt{Fn} key, while simultaneously pressing the \texttt{F7} key.
3. You may toggle through the options to display the LCD only, the external display alone and the LCD and the external display together (make sure you allow time for the screens to refresh as you toggle through).

\textbf{Using the Driver to Switch Displays}

If you only use the keyboard toggle to switch through the display options you will not have all the configuration options available to you. If you want to access the options listed in “\textit{Display Devices}” on page 3 - 11 use the driver control panel to configure the settings as per “\textit{Switching/Enabling Displays (Driver)}” on page 3 - 12.
Advanced Controls

Switching/Enabling Displays (Driver)

With the video driver installed (see pages 4 - 9 & 4 - 15), you can use its built-in controls to switch between the displays as follows:

1. Plug the monitor into the appropriate port.
2. Go to the Intel(R) 82852/82855 GM/GME Graphics Controller Properties control panel (see “Intel Video Driver Controls” on page 3 - 8) and select Devices (tab).
3. Choose the display option from the list on the left and click Apply (and OK to confirm the settings change).
4. You can choose a device to be Primary or Secondary.

See the following pages for instructions on enabling Clone and Extended Desktop modes.

Vertical Refresh Rate

The vertical refresh rate of your monitor is important. If it is too low and/or you’re using fluorescent lighting, the screen will appear to flicker. To reduce flickering on a monitor, use faster refresh rates (we recommend a refresh rate of 72Hz or more). But first check your monitor’s documentation to make sure it can support the rates listed by the video driver. The default refresh rate for monitors (without drivers) is 60Hz.
**Multi-Monitor Modes**
In addition to the single LCD display mode you have the following Multi-Monitor modes available when the external monitor is attached.

**Intel(R) Dual Display Clone**
This mode will drive multiple displays with the same content. Use this feature to display the screen through a projector for a presentation.

**Extended Desktop**
This mode allows a desktop to span multiple displays and acts as a large workspace. This creates a lot more screen area for display. Use the Display Properties control panel to drag the monitors to match the physical arrangement you wish to use, or you may also use the Extended Desktop Settings control panel tab in Intel(R) 82852/82855 GM/GME Graphics Controller Properties to configure the relative size and position.

---

**Function Key Combinations**
You can use the **Fn + F7** key combination to toggle through the display options:
- LCD Only
- Monitor Only
- LCD + Monitor

Make sure you give the displays enough time to refresh.
To Enable Dual Display Clone Mode:
1. Plug the monitor into the appropriate port.
2. Go to the Intel(R) 82852/82855 GM/GME Graphics Controller Properties control panel (see “Intel Video Driver Controls” on page 3 - 8) and select Devices (tab).
3. Click the Intel(R) Dual Display Clone icon in the devices tab (Note: this option is only available when you have attached the monitor).
4. Choose which device is to be the Primary display, and which is to be Secondary.
5. Adjust the settings by clicking the Device Settings (button) if necessary.
6. Click Apply > OK and close the control panels.

Figure 3 - 8
Device Settings
(Clone Mode)
To Enable Extended Desktop Mode:
1. Plug the monitor into the appropriate port.
2. Go to the Intel(R) 82852/82855 GM/GME Graphics Controller Properties control panel (see “Intel Video Driver Controls” on page 3 - 8) and select Devices (tab).
3. Click the Extended Desktop icon in the devices tab (Note: this option is only available when you have attached the monitor).
4. Choose which device is to be the Primary display, and which is to be Secondary.
5. Adjust the settings by clicking the Device Settings (button) if necessary.
6. Click Apply > OK and close the control panels.

You can also enable the Extended Desktop mode from the Display Properties control panel (see “Display Properties” on page 3 - 7).
To Enable Extended Desktop (Display Properties)
1. Plug the monitor into the appropriate port.
2. Click Start, point to Settings (or just click Control Panel) and click Control Panel (if you are in Category View choose Appearance and Themes).
3. Double-click Display (icon).
4. In the Display Properties dialog box, click Settings (tab).
5. Click the monitor icon (e.g. 2), and make sure you have checked “Extend my Windows desktop onto this monitor.” and click Apply.

Click the appropriate monitor icon to be able to select the option to extend the desktop on to it.

Use the control panel to drag the monitors to match the physical arrangement you wish to use. In the example shown in Figure 3 - 10 the primary monitor 1 is on the left; the secondary display is on the right. You can drag any icons or windows across to either display desktop, which makes it possible to have one program visible in one of the displays, and a different program visible in the other display.
Power Management Features

To conserve power, especially when using the battery, your computer uses the ACPI power management system. Power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system.

Advanced Configuration and Power Interface

The ACPI interface provides the computer with enhanced power saving techniques and gives the operating system (OS) direct control over the power and thermal states of devices and processors. For example, it enables the OS to set devices into low-power states based on user settings and information from applications. ACPI is fully supported in Windows XP and Windows 2000.
Enabling Power Options

Power Options are enabled through the control panel in your Windows system (Power Options). With other operating systems you may have power management available, so check your documentation.

You may conserve power through Power Schemes (individual components) or throughout the whole system.

Figure 3 - 11
Power Options
Control Panel
Power Schemes

You can set your computer to conserve power through individual components by means of **Power Schemes**. You can also adjust the settings for each scheme to set the monitor to turn off after a specified time, and the computer's hard disk motor to turn off if the hard disk drive has not been accessed for a specified period of time (if the system reads or writes data, the hard disk motor will be turned back on). The schemes may also be set to set a specified time for the system to enter **Standby** or **Hibernate** modes (see “Conserving Power (System)” on page 3 - 21).

**Resuming Operation**

The system can resume from Monitor or Hard Disk Standby by pressing a key on the keyboard.

![Power Schemes Configuration](image)
Each *Windows Power Scheme* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose the *Home/Office* scheme for maximum performance when the computer is powered from an AC power source. Choose the *Max Battery* scheme (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.

For advanced information see “*Power Schemes & Processor Performance*” on page *A - 2*. This Appendix also contains information on the “*Intel CPU SpeedStep Controls*” (on page *A - 3*) which help you maximize the balance between power saving and processor performance.
Conserving Power (System)

With this function you can stop the computer’s operation and restart where you left off. This system features **Standby** and **Hibernate** sleep mode levels (Hibernate mode will need to be enabled by clicking the option in the **Hibernate** tab in the **Power Options** control panel - *Figure 3 - 13 on page 3-22*).

**Hibernate Mode vs. Shutdown**

Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

You can use either method depending on your needs.

**Standby Mode vs. Hibernate Mode**

If you want to stay away from your work for just a while, you can put the system on standby instead of in hibernation. It takes a longer time to wake up the system from Hibernate mode than from Standby mode.
Advanced Controls

Standby
Standby saves the least amount of power, but takes the shortest time to return to full operation. During Standby the hard disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained in memory. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Standby mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although it saves the most power it takes the longest time to return to full operation. You can set your computer to automatically enter Hibernate mode when the battery power is almost depleted. You will need to enable Hibernate mode from the Hibernate tab in the Power Options control panel. The system will resume from Hibernate mode by pressing the power button.

Enable Hibernation
Configuring the Power Button
The power button may be set to send the computer into either Standby or Hibernate mode. In Standby mode, the LED (\( \cup \)) will flash green. In Hibernate mode the LED will be Off (battery powered)/Orange (AC Adapter powered). In a power saving mode set to save power through individual components (e.g. hard disk, monitor), the LED will remain green.

Lid Button
It is recommended that you set the lid (left LCD cover sensor) power button to “Do nothing”. This will prevent accidentally triggering a power saving mode when you rotate the LCD swivel screen.

Sleep Button
You may also configure the Sleep/Resume key combination (Fn + F4) from the menu illustrated in Figure 3 - 14. In Windows this is referred to as the Sleep button.
Battery Information

Follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery before using it (see “Battery FAQ” on page 3 - 25 for instructions on how to do this).

Battery Life
Your computer’s battery life is dependent upon many factors, including the programs you are running, and peripheral devices attached. Power Options (you may set low battery Alarms and actions, and check the Power Meter from the Power Options control panel), and settings in the OS will help prolong the battery life if configured appropriately.

Caution
Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.

Figure 3 - 15
Power Options (Alarm & Power Meter)
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason see “Removing the Battery” on page 6 - 3.

Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer by yourself even when you see a message that indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own (it is best to disable the Power Options functions in the Control Panel). As the battery nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.

Conserving Battery Power
To conserve battery power:
Lower the brightness level of the LCD display.
Close modem or communication applications when they are not being used.
Remove any unused PC Cards from the computer (PC Cards quickly use up battery power even if the system enters sleep mode).
Disconnect any unnecessary external devices.
Advanced Controls

PC Camera

If you have purchased the optional PC Camera you will need to install the device driver for it as indicated in “PC Camera (Win2000)” on page 4-12 and “PC Camera (WinXP)” on page 4-19. The optional PC Camera driver is provided on its own CD, and is not on the Device Drivers & Utilities + User’s Manual CD-ROM.

After installing the driver you can run the application software by going to the CMM PC Camera item in the Start > Programs/All Programs menu and selecting the AMCAP program. If you are using the Windows XP operating system you can double-click the CMM PC Camera icon in My Computer to take still pictures (see sidebar).

Taking Still Pictures

You may take still pictures in the Windows XP operating system only.

Double-click the My Computer icon on the desktop, or go the Start menu and point to My Computer, then click it.

Double-click the CMM PC Camera icon.

Click Take a new picture in the Camera Tasks box.

Latest PC Camera Driver Information

Check the PC Camera CD, and any accompanying insert pages, for the latest updated information on the PC Camera driver, which may override the information provided here.
PC Camera Audio Setup

If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

(WinXP)
1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Sounds & Audio Devices icon (Category View > Speech, and Audio Devices).
2. Click Advanced in the Volume tab.
3. Click Options (Volume Control) and scroll down and click Properties.
4. Click Recording (Adjust volume for) and click Microphone (check box), then click OK.
5. Make sure the Select (check box) in the Recording Control panel, under the Microphone section, is checked (boost the volume as high as it will go).
6. Close the open windows.

(Win2000)
1. Go to the Start menu and point to Settings and click Control Panel then double-click the Sounds and Multimedia icon.
2. Click Audio (tab) and click Volume (button) in the Sound Recording menu.
3. Select Advanced Controls from the Options menu.
4. Make sure the Select (check box) in the Microphone section is checked, and boost the volume as high as it will go.
5. Close the windows.
Advanced Controls

Figure 3 - 16
Audio Setup

3 - 28 PC Camera
AMCAP
AMCAP is a video viewer useful for general purpose video viewing and testing, and capturing video files to .avi format.

1. Run the AMCAP program from the Start > Programs/All Programs > CMM PC Camera menu (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio make sure that the Capture Audio option is ticked) and select Start Capture.
3. On the first run of the program (if you have not set the captured file) you will be asked to choose a file name and size (see the sidebar - Pre-Allocating File Space) for the captured file. Click Start Capture again.
4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video As..., choose a file name and location, then click Open (you can view the file using the Windows Media Player).

Set Capture File
In AMCAP program you will only be asked to set the capture file name on the first run of the program. When you run the program the next time the file will automatically be overwritten with the newly captured file. To avoid overwriting files you can go to the Set Capture File.. option in the File menu, and set the file name and location before capture. Set the name and location then click Open (you can choose Cancel to ignore the file size if prompted).

Pre-Allocating File Space
You may pre-allocate the file size for the capture file in the AMCAP program. You can choose to ignore this by clicking Cancel.

Pre-allocating space on the hard disk can improve the capture quality (particularly of large capture files), by reducing the amount of work the hard disk has to do in finding space for the video data as it is being captured.

You may find it helpful to defragment the HDD before capture.
Eliminating Screen Flicker
If you find that the video screen in the AMCAP program is flickering, you can try to adjust the option from the Video Capture Filter options.
1. Run the AMCAP program from the Start > Programs/All Programs > CMM PC Camera menu.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. You can choose either 50Hz or 60Hz from the No Flicker box.

Figure 3 - 17
Camera Controls
Wireless LAN Module

The computer’s 802.11b Wireless LAN module, and its antenna and other components, are not externally visible (please check with your service representative). Make sure you install the driver (see pages 4 - 11 & 4 - 17). The 802.11b Wireless LAN module driver is provided on its own CD, and is not on the Device Drivers & Utilities + User’s Manual CD-ROM. You will also find instructions on pages 4 - 12 & 4 - 18 for accessing the User Guides. Make sure the wireless module is OFF when you are using the computer aboard aircraft (see sidebar note).

You can configure the wireless network settings from the full instructions provided in the User Guides. Some general Windows networking control panels are illustrated overleaf. These control panels can be accessed by clicking the Start (menu), browsing to Settings, and clicking Network Connections/Network and Dial-Up Connections (or Connect To > Show all connections in WinXP default Start menu configuration).

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module is OFF if you are using the computer aboard aircraft.

When your computer ‘Boots Up’ the module will be ON.

To toggle power to the WLAN module use the key combination Fn + F11, or the “VGA Rotate Application” on page 3 - 4.
Advanced Controls

Figure 3 - 18
Network Control Panels

Windows XP

Windows 2000
Chapter 4: Drivers & Utilities

Overview

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities. In this chapter, we group driver and utility installation instructions by operating system. The following operating systems are covered.

- Windows 2000 (with Service Pack 4 included)
- Windows XP Professional & Home Editions

Assumption

We assume that you will install all drivers and utilities from the built-in CD device and it is assigned to “Drive D:”. In addition, all file extensions can be seen [see “Navigate (Browse..) to D:” on page 4 - 4].
What to Install

The Device Drivers & Utilities + User’s Manual CD-ROM contains the drivers and utilities necessary for the proper operation of the computer. (The drivers for the Wireless LAN and optional PC Camera modules and are on the separate CDs provided.) Table 4 - 1 on page 4-7 lists what you need to install manually according to your choice of the operating system. It is very important that the drivers are installed in the order indicated in the table.

Windows XP & 2000 Service Packs

Check the warnings on this page regarding installation of the appropriate Service Pack for your Windows XP OS (if you are unsure of the Service Pack currently installed see “Service Pack Installed” on page 4 - 3). Make sure you have installed the appropriate Service Pack before installing all the drivers if you are using Windows XP. Make sure that your Windows 2000 version includes Service Pack 4 on the installation CD.

Windows XP Service Pack 1/1a

Make sure you install Windows XP Service Pack 1/1a (or a Windows XP version which includes Service Pack 1/1a) before installing any drivers. Service Packs 1 and 1a include support for USB 2.0.

If you have upgraded the system by installing Service Pack 1/1a (i.e. your Windows XP version does not include Service Pack 1/1a) then follow these instructions:

1. Go to Device Manager (see step 1 of the Touch Panel driver installation instructions on page 4 - 20) and click “+” next to Other devices (if its sub-items are not shown).
2. Right-click Universal Serial Bus (USB) Controller and select Uninstall > OK.
3. Restart the computer and it will find the USB 2.0 controller.
Drivers & Utilities

Windows 2000 with Service Pack 4
Make sure that your Windows 2000 version includes Service Pack 4 on the installation CD.

Windows 2000 (SP4) Internet Explorer 5.5 & DirectX 8.1
Make sure that you install Internet Explorer 5.5 (or higher version) if you are using the Windows 2000 (with Service Pack 4 installed) OS.
Make sure that you go to the Microsoft website to download and install DirectX 8.1 (or higher version) if you are using the Windows 2000 (SP4) OS.

Service Pack Installed
To see which Service Pack is currently installed on your computer go to the General tab of the System control panel. Right-click the My Computer icon on the desktop or in the Start menu (in WinXP only) and select Properties. The Service Pack currently installed on your system will be listed under the “System:” heading. (If no Service Pack information is listed, then no Service Pack is installed.)
Drivers & Utilities

New Hardware Found
If you see the message “New Hardware Found” (Found New Hardware Wizard) during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure as directed.

Navigate (Browse..) to D:
You will notice that many of the instructions for driver installation require you to "Navigate (Browse) to D:"

In this case “D:” is the drive specified for your CD device. Not all computers are setup the same way, and some computers have the CD listed under a different drive letter - e.g. if you have two hard drives (or hard disk partitions) one may be designated as “Drive C:” and the other as “Drive D:”. In this case the CD device may be designated as “Drive E:” - Please make sure you are actually navigating to the correct drive letter for the CD device.

When you click the Browse (button) after clicking Run in the Start menu you will see the “Look in:” dialog box at the top of the Browse window. Click the scroll button to navigate to My Computer to display the devices and drive letters.
Drivers & Utilities

Authorized Driver Message
If you receive a message telling you that the driver you are installing is not authorized (Digital Signature Not Found), just click Yes or Continue Anyway to ignore the message and continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

Version Conflict Message
During driver installation if you encounter any “file version conflict” message, please click Yes to choose to keep the existing (newer) version.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Add/Remove Programs item. If you see the individual driver listed (if not see below), uninstall it, following the on screen prompts (it may be necessary to restart the computer). Go to the appropriate section of the manual to complete the update/reinstall procedure for the driver in question.

If the driver is not listed in the Add/Remove Programs item:
1. Click Start (menu), point to Settings and click Control Panel. Double-click System (icon) and then click Hardware (tab) > Device Manager (button).
2. Double-click the device you wish to update/reinstall the driver for (you may need to click “+”).
3. Look for the Update Driver button (check the Driver tab) and follow the on screen prompts.
Driver Installation

You have a choice of installation methods to install your drivers.

Automatic Driver Installation

Insert the Device Drivers & Utilities + User’s Manual CD-ROM and the Drivers Installer application will run automatically.

1. Check the driver installation order from the table Table on page 4-7 (the drivers must be installed in this order).
2. Click the driver you wish to install, and click Yes to continue (do not press any keys).
3. Follow the installation procedure as listed in the manual installation process (the automatic installation procedure eliminates the need to navigate to the setup executable file).
4. If the computer needs to restart after installing a driver, you can return to the Drivers Installer screen by either:
   - Clicking Start (menu) > Run… and navigating (Browse..) to D:\DriverInstaller.exe and clicking OK.
   - OR
   - Ejecting and re-inserting the CD.
   - OR
   - Double-clicking the My Computer icon, and then double-clicking CD icon (WinXP only).

Note: The drivers for the Wireless LAN and optional PC Camera modules and are on the separate CDs provided. The Touch Panel driver (for Model A computers only) must be installed manually.
Manual Driver Installation

Insert the *Device Drivers & Utilities + User’s Manual CD-ROM* and close the *Drivers Installer* application. Follow the procedures listed in this chapter (the drivers for the *Wireless LAN* and *optional PC Camera* modules and are on the separate CDs provided).

*Service Pack Installed

To see which *Service Pack* is currently installed on your computer go to the *General* tab of the *System* control panel. Right-click the *My Computer* icon on the desktop or in the *Start* menu (in *WinXP only*) and select *Properties*. The Service Pack currently installed on your system will be listed under the “*System:”* heading. (If no Service Pack information is listed, then no Service Pack is installed.)

**Table 4 - 1 - Install Order**

<table>
<thead>
<tr>
<th>Driver</th>
<th>Win 2000 (SP4)</th>
<th>Win XP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Pack</td>
<td>Make sure Service Pack 4 is included on the installation CD</td>
<td>Install Windows Service Pack 1/1a if not included*</td>
</tr>
<tr>
<td>Chipset</td>
<td>page 4 - 8</td>
<td>page 4 - 14</td>
</tr>
<tr>
<td>Audio</td>
<td>page 4 - 9</td>
<td>page 4 - 14</td>
</tr>
<tr>
<td>Video (VGA)</td>
<td>page 4 - 9</td>
<td>page 4 - 15</td>
</tr>
<tr>
<td>LAN</td>
<td>page 4 - 9</td>
<td>page 4 - 15</td>
</tr>
<tr>
<td>Modem</td>
<td>page 4 - 9</td>
<td>page 4 - 15</td>
</tr>
<tr>
<td>ENE-PCMCIA</td>
<td>page 4 - 10</td>
<td>page 4 - 16</td>
</tr>
<tr>
<td>TouchPad</td>
<td>page 4 - 10</td>
<td>page 4 - 16</td>
</tr>
<tr>
<td>Wireless LAN</td>
<td>page 4 - 11</td>
<td>page 4 - 17</td>
</tr>
<tr>
<td>PC Camera</td>
<td>page 4 - 12</td>
<td>page 4 - 19</td>
</tr>
<tr>
<td>Screen Rotation</td>
<td>page 4 - 13</td>
<td>page 4 - 19</td>
</tr>
<tr>
<td>Touch Panel</td>
<td>page 4 - 13</td>
<td>page 4 - 20</td>
</tr>
</tbody>
</table>

(Model A only)
Drivers & Utilities

Windows 2000

This section covers driver and utility installation instructions for the *Windows 2000 (SP4 installed)*.

**Chipset (Win2000)**

1. Click **Start** (menu) > **Run**...
2. Navigate (**Browse..**) to `D:\Drivers\inf_update\infinst_autol.exe` and click **OK**.
3. Click **Next** > **Yes** > **Next**.
4. Click **Finish** to restart the computer.

**Windows 2000 with Service Pack 4**

Make sure that your *Windows 2000* version includes *Service Pack 4 on the installation CD*.

**Windows 2000 (SP4) Internet Explorer 5.5 & DirectX 8.1**

Make sure that you install *Internet Explorer 5.5 (or higher version)* if you are using the *Windows 2000 (with Service Pack 4 installed)* OS.

Make sure that you go to the Microsoft website to download and install *DirectX 8.1 (or higher version)* if you are using the *Windows 2000 (SP4)* OS.
Audio (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Drivers\Audio\Setup.exe and click OK.
3. Click Next.
4. Click Finish to restart the computer.
5. You can click the AC97 Audio Configuration icon in the taskbar for configuration options.

Video (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Drivers\VGA\Setup.exe and click OK.
3. Click Next > Yes (click Continue Anyway if asked if you want to continue).
4. Click Finish to restart the computer.
5. See “Video Driver Controls” on page 3 - 6 for details on adjusting the video settings.

LAN (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Drivers\Lan\Setup.exe and click OK.
3. Click Next.
4. Click Finish.
5. The network settings can now be configured.

Modem (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Drivers\Modem\Win2K\Setup.exe and click OK.
3. Click (button).
4. Click .
5. The modem is ready for dial-up configuration.

Modem Country Selection
Be sure to check if the modem country selection is appropriate for you (Control Panel > Phone and Modem Options).
Drivers & Utilities

ENE-PCMCIA (Win2000)
This driver is also required by the 4-in-1 Card Reader.
1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Drivers\ENE-PCMCIA\Setup.exe and click OK.
3. Click Next > Next.
4. Click Finish to restart the computer.

TouchPad (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to D:\Drivers\TouchPad\Setup.exe and click OK.
3. To continue click Next > Next > Next (click Yes if asked if you want to continue).
4. Click Finish to restart the computer.
5. You may then configure your TouchPad as outlined in “TouchPad and Buttons/Mouse” on page 2 - 25.
Wireless LAN (Win2000)

Make sure the module is powered on before installing the driver. To toggle power to the WLAN module use the key combination **Fn + F11**, or “VGA Rotate Application” on page 3 - 4.

1. Insert the **Intel PRO CD-ROM** into the CD drive.
2. Click **Wireless LAN Adapters** (button).
3. Click **Install Software** (button).
4. Click **Next**.
5. Click the button to accept the license and click **Next > Next > Install > Finish**.
6. Click **Start** (menu), point to **Settings** and click **Control Panel**. Double-click **System** (icon) and then click **Hardware** (tab) > **Device Manager** (button).
7. Click **Device Manager** (tab), then click “+” next to **Other Devices** (if its sub-items are not shown).
8. Double-click **Network Controller**, and click the **Reinstall Driver** (button).
9. When the **Upgrade Device Driver Wizard** appears, click **Next** (make sure that you have selected “Search for a suitable driver for my device (recommended)” and click **Next**.
10. When **Locate Driver Files** appears, select ONLY “Specify a location” and click **Next**.
11. Navigate (Browse...) to **D:\PROW7100\WIN2K**.
12. Click **Open > OK > Next**.
13. Click **Finish** and close the open windows.

You can now install the Administration Tools.

1. Insert the **Intel PRO CD-ROM** into the CD drive.
2. Click **Wireless LAN Adapters** (button).
3. Click **Install Administration Tools** (button).
4. Click **Next**.
5. Click the button to accept the license and click **Next > Next > Install > Finish**.
6. You can configure the settings by going to the **Start** menu and pointing to **Programs** and clicking **Intel Network Adapters**, then clicking either the **Intel (R) PROset** icon, or the options under the **Access Point Administration Tools**.
Drivers & Utilities

You can view the User Guides by inserting the Intel PRO CD-ROM and clicking Wireless LAN Adapters (button) > View User Guides (button).

PC Camera (Win2000)

1. Insert the PC Camera CD-ROM into the drive.
2. The program will run automatically.
3. Click Next (click Yes if asked if you want to continue at any time).
4. Click Finish and restart the computer.
5. After restart the computer will find the new hardware for you (click Yes if asked if you want to continue at any time).
6. To run the application software go to the CMM PC Camera item in the Start > Programs menu and select the AMCAP program (see “PC Camera” on page 3 - 26).

Latest PC Camera Driver Information

Check the PC Camera CD, and any accompanying insert pages, for the latest updated information on the PC Camera driver, which may override the information provided here.
Screen Rotation (Win2000)
1. Click **Start** (menu) > **Run**...
2. Navigate (**Browse**) to D:\Drivers\VGA-Rotate-AP\SETUP.EXE and click **OK**.
3. Click **Next**.
4. Click **Finish** to restart the computer.

Touch Panel (Win2000)
Only **Model A** computers support touch panel features. If your computer is **Model B** it is not necessary to install the driver.

1. Click **Start** (menu), point to **Settings** and click **Control Panel**. Double-click **System** (icon) and then click **Hardware** (tab) > **Device Manager** (button).
2. Click **Device Manager** (tab), then click “+” next to **Mice and other pointing devices** (if its sub-items are not shown).
3. Double-click **Microsoft Serial Mouse**, and click the **Driver** (tab).
4. Click **Update Driver** (button).
5. When the **Upgrade Device Driver Wizard** appears click **Next**.
6. Select “Display a list of the known drivers for this device so that I can choose a specific driver” and click **Next**.
7. Click **Have Disk** (button) and navigate (**Browse**) to D:\Drivers\Touch Panel and click **Open** > **OK** > **Next** (click Yes if asked if you want to continue).
8. Click **Next** (click Yes if asked if you want to continue).
9. Click **Finish** and close the open windows.
10. See “Touch Panel (Model A Only)” on page 2 - 19.
Drivers & Utilities

Windows XP

This section covers driver and utility installation instructions for the Windows XP OS.

Chipset (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Drivers\inf_update\infinst_autol.exe and click OK.
3. Click Next > Yes > Next.
4. Click Finish to restart the computer.

Audio (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Drivers\Audio\Setup.exe and click OK.
3. Click Next.
4. Click Finish to restart the computer.
5. You can click the AC97 Audio Configuration icon in the taskbar for configuration options.

Windows XP Service Pack 1/1a

Make sure you install Windows XP Service Pack 1/1a (or a Windows XP version which includes Service Pack 1/1a) before installing any drivers. Service Packs 1 and 1a include support for USB 2.0.

If you have upgraded the system by installing Service Pack 1/1a (i.e. your Windows XP version does not include Service Pack 1/1a) then follow these instructions:

1. Go to Device Manager (see step 1 of the Touch Panel driver installation instructions on page 4 - 20) and click “+” next to Other devices (if its sub-items are not shown).
2. Right-click Universal Serial Bus (USB) Controller and select Uninstall > OK.
3. Restart the computer and it will find the USB 2.0 controller.
Drivers & Utilities

Video (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Drivers\VGA\Setup.exe and click OK.
3. Click Next > Yes.
4. Click Finish to restart the computer.
5. See “Video Driver Controls” on page 3 - 6 for details on adjusting the video settings.

LAN (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Drivers\Lan\Setup.exe and click OK.
3. Click Next.
4. Click Finish.
5. The network settings can now be configured.

Modem (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse..) to D:\Drivers\Modem\WinXP\Setup.exe and click OK.
3. Click (button).
4. Click .
5. The modem is ready for dial-up configuration.

Modem Country Selection
Be sure to check if the modem country selection is appropriate for you (Control Panel > Phone and Modem Options).
Drivers & Utilities

**ENE-PCMCIA (WinXP)**
This driver is also required by the 4-in-1 Card Reader.
1. Click **Start** (menu) > **Run**...
2. Navigate (**Browse..**) to D:\Drivers\ENE-PCMCIA\Setup.exe and click **OK**.
3. Click **Next** > **Next**.
4. Click **Finish** to restart the computer.

**TouchPad (WinXP)**
1. Click **Start** (menu) > **Run**...
2. Navigate (**Browse...**) to D:\Drivers\TouchPad\Setup.exe and click **OK**.
3. To continue click **Next** > **Next** > **Next** (click **Continue Anyway** if asked if you want to continue).
4. Click **Finish** to restart the computer.
5. You may then configure your TouchPad as outlined in “**TouchPad and Buttons/Mouse” on page 2 - 25.”
Wireless LAN (WinXP)
Make sure the module is powered on before installing the driver. To toggle power to the WLAN module use the key combination Fn + F11, or “VGA Rotate Application” on page 3 - 4.

1. Insert the Intel PRO CD-ROM into the CD drive.
2. Click Wireless LAN Adapters (button).
3. Click Install Software (button).
4. Click Next.
5. Click the button to accept the license and click Next > Next > Install > Finish.
6. If you can see the My Computer icon on your desktop (if you cannot see the My Computer icon go to step 7) click on it once to select it, then right-click it to make the sub-menu appear and scroll down to Properties and click on it (go to step 8).
7. If you cannot see the My Computer icon click Start (menu), then point to (but don’t click just highlight it) My Computer. Right-click it to make the sub-menu appear and scroll down to Properties and click on it (go to step 3).
8. Click the Hardware (tab), then click Device Manager (button).
9. Click “+” next to Other Devices (if its sub-items are not shown).
10. Double-click Network Controller and click Reinstall Driver (button).
11. When the Hardware Update Wizard appears, click “Install from a list or specific location (Advanced)” then click Next.
12. Select “Search for the best driver in these locations.” and select ONLY “Include this location in the search:”.
13. Navigate (Browse...) to D:\PROW7100\WINXP and click OK > Next.
14. Click Finish and close the open windows.

You can now install the Administration Tools (see over).
Drivers & Utilities

1. Insert the *Intel PRO CD-ROM* into the CD drive.
2. Click Wireless LAN Adapters (button).
3. Click Install Administration Tools (button).
4. Click Next.
5. Click the button to accept the license and click Next > Next > Install > Finish.
6. You can configure the settings by going to the Start menu and pointing to Programs/All Programs and clicking Intel Network Adapters, then clicking either the Intel (R) PROset icon, or the options under the Access Point Administration Tools.

You can view the User Guides by inserting the *Intel PRO CD-ROM* and clicking Wireless LAN Adapters (button) > View User Guides (button).

Figure 4 - 3
View User Guides
PC Camera (WinXP)

1. Insert the **PC Camera CD-ROM** into the drive.
2. The program will run automatically.
3. Click **Next** (click **Continue Anyway** if asked if you want to continue at any time).
4. Click **Finish** to restart the computer.
5. When the **Found New Hardware Wizard** appears select **“Install the software automatically (Recommended)”** then click Next.
6. Click **Finish** and restart the computer (click **Yes** to do so automatically when the dialog box appears).
7. To run the application software go to the **CMM PC Camera** item in the **Start > Programs/All Programs** menu, and select the **AMCAP** program.
8. Double-click the **CMM PC Camera** icon in **My Computer** to take still pictures (see “**PC Camera**” on page 3 - 26).

Screen Rotation (WinXP)

1. Click **Start** (menu) > **Run**...
2. Navigate (**Browse...**) to **D:\Drivers\VGA-Rotate-AP\SETUP.EXE** and click **OK**.
3. Click **Next**.
4. Click **Finish** to restart the computer.
Drivers & Utilities

Touch Panel (WinXP)

Only Model A computers support touch panel features. If your computer is Model B it is not necessary to install the driver.

1. If you can see the My Computer icon on your desktop (if you cannot see the My Computer icon go to step 2) click on it once to select it, then right-click it to make the sub-menu appear and scroll down to Properties and click on it (go to step 3).

2. If you cannot see the My Computer icon click Start (menu), then point to (but don’t click just highlight it) My Computer. Right-click it to make the sub-menu appear and scroll down to Properties and click on it (go to step 3).

3. Click the Hardware (tab), then click Device Manager (button).

4. Click “+” next to Mice and other pointing devices (if its sub-items are not shown).

5. Double-click Microsoft Serial Mouse and click Driver (tab).

6. Click Update Driver (button).

7. When the Hardware Update Wizard appears, click “Install from a list or specific location (Advanced)” then click Next.

8. Select “Don’t search. I will choose the driver to install.” and click Next.

9. Click Have Disk (button) and navigate (Browse...) to D:\Drivers\Touch Panel and click Open > OK > Next (click Yes and/or Continue Anyway if asked if you want to continue).

10. Click Finish and close the open windows.

Chapter 5: BIOS Utilities

Overview

This chapter is about the computer’s built-in software.

Your computer comes with built-in BIOS (Basic Input Output System) which is an essential set of software routines stored on a chip in your computer. These routines serve to describe your computer’s hardware to your chosen operating system, and provides an interface between the two. The BIOS includes the POST (Power On Self Test) and the SCU (System Configuration Utility). The POST performs diagnostic procedures at startup, the SCU allows you to configure your computer.

There is one general rule: *Don’t make any changes unless you are sure of what you are doing.* Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.

If your computer has never been set up, or you are making important changes to the system, then you should review this chapter first and note the original settings found in the SCU. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.
The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a POST, including a quick test of the on-board RAM. As the POST proceeds, the computer will tell you if there is anything wrong. If there is a problem which prevents the system from booting, it will display a system summary and prompt you to run SCU. If you do not see the POST screen see the sidebar for information on the Fast Boot and Display OEM logo options.

If there are no problems, the SCU (System Configuration Utility) prompt will disappear and the system will load the operating system. Once that starts, you can’t get into the SCU without rebooting the computer.

---

**The POST Screen**
- BIOS information
- CPU type
- Memory status
- Enter SCU prompt

Note: The POST screen pictured is for guideline purposes only. The POST screen on your computer may appear slightly different. If you choose the Fast Boot option you will see an abbreviated version of this screen. If you choose the Display OEM logo the screen will not appear (see page 5 - 4.)

---

*Figure 5 - 1*
POST Screen

---

5 - 2 The Power-On Self Test (POST)
Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) followed by the prompt:

- Press <F1> to resume
- <F2> to enter System Configuration Utility

Press F1 to see if the boot process can continue. It may work, without the correct configuration.

Press F2 to run the SCU program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The System Configuration Utility

The SCU program tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration and power management). The settings are stored in a nonvolatile battery and written to the CMOS RAM. This means that the settings are saved even when the computer is turned off.

Entering Setup

To enter the SCU, turn on the computer and press F2 when you see the prompt “<F2> to enter System Configuration Utility”. The prompt seen in Figure 5 - 1 is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error” just press F2 again.

If the computer is already on, reboot and then hold down F2 when you see the prompt. The SCU’s main menu will appear.

Entering Setup with Display OEM Logo Enabled

To enter the SCU with the Display OEM Logo enabled (see “Display OEM logo (Startup Menu)” on page 5 - 10) you will need to press F2 when you see the message “Press the <F2 Key> to enter the System Configuration Utility” appear on the screen.

BIOS Settings V’s OS Settings

Though many options such as power management and display settings may be set in the BIOS, these are usually best set in your OS (e.g. Windows).

Older OS’s such as DOS etc. may still rely entirely on the setup information from the BIOS. “Plug-n-Play” OS’s, such as the various Windows systems, may override these settings with the settings from the system’s Control Panel.
# Working with the Menu Bar

You can use the mouse to navigate around the various menus and submenus of the SCU, or alternatively, you can use the following key combinations:

<table>
<thead>
<tr>
<th>Keys</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt</td>
<td>Activates the menu bar</td>
</tr>
<tr>
<td>Left arrow/Right arrow → ← Type the highlighted letters</td>
<td>Selects an option in the menu bar</td>
</tr>
<tr>
<td>Left mouse button Down arrow Spacebar Enter</td>
<td>Opens the pull-down menu bar options</td>
</tr>
<tr>
<td>Right mouse button Esc</td>
<td>Cancels the action</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 5 - 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCU Menu Navigation Keys</td>
</tr>
</tbody>
</table>
Working with the Pull-Down Menu

Once your desired menu bar item is highlighted, press Enter or left-click with the mouse to see the pull-down menu items. The following keys allow you to move about the pull-down menu:

<table>
<thead>
<tr>
<th>Keys</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Down/Up arrows (↓↑)</td>
<td>Changes the value</td>
</tr>
<tr>
<td>Enter</td>
<td>Allows you to choose:</td>
</tr>
<tr>
<td></td>
<td>&lt;OK&gt; to save changes</td>
</tr>
<tr>
<td></td>
<td>&lt;Cancel to ignore any changes&gt;</td>
</tr>
</tbody>
</table>
Working with Sub-Menus

Some pull-down menu options have an arrow to the right of the entry which indicates a sub-menu is available. Choose these sub-menus by pressing Enter and the screen will be displayed. Navigate through these screens by using the keys in the table below:

<table>
<thead>
<tr>
<th>Keys</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Moves from one field to another</td>
</tr>
<tr>
<td>Down/Up arrows (↓↑)</td>
<td>Selects an item within the field</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Enables the specified function (a dot indicates the function is enabled)</td>
</tr>
<tr>
<td>OK/Enter</td>
<td>Accepts the entries and closes the sub-menu and saves the changes</td>
</tr>
<tr>
<td>Cancel/Esc</td>
<td>Rejects the entries and closes the sub-menu</td>
</tr>
</tbody>
</table>

SCU Screens

The screens which appear on the following pages are intended as a guideline.

It should be noted that the screen on your particular computer may appear a little differently.

Table 5 - 3
Sub Menus
(Right Arrow Enabled)
Fast Boot (Startup Menu)
Enable this option to eliminate the memory test and other delays at power-up. It is enabled by default.
**Boot Device (Startup Menu)**
Specify which device your computer should look on for an operating system by priority. The default setting for the first boot device is *Diskette A* (external floppy disk), the second boot device is *Hard Disk C* (internal hard disk), the third boot device is the *CD-ROM Drive* (external CD device) and the fourth boot device is *PXE LAN* (network boot). You may also set the computer to boot from the *USB HDD* (external USB hard disk). If the computer fails to find an operating system on the first device in the priority list it will then move on to look on the second device etc.

**Display (Startup Menu)**
Enables your choice of CRT (external monitor), LCD (the computer’s display screen), or both. These settings are best changed in your OS (see “Display Devices” on page 3 - 11), and may also be quickly adjusted by means of the **Fn** and **F7** key combination (see “The Keyboard” on page 2 - 17). However if you want to use multiple display devices in OS’s other than Windows, you may set the options here.

**Enable Battery Low Beep (Startup Menu)**
Enable or disable the low battery beep if the power is getting low. It is enabled by default.
Enable Power On Beep (Startup Menu)
Enable or disable (disabled by default) the beep when the computer “boots up”.

Display OEM logo (Startup Menu)
Enable or disable (enabled by default) the display of the OEM logo (if applicable) during the POST process.

Fast Boot for Windows XP (Startup Menu)
Enable or disable (enabled by default) the fast system startup option if you are using the Windows XP OS.

Boot and SCU Passwords (Startup Menu)
You can set the passwords for when the computer starts-up (Boot Password), and for access to the SCU to make changes (SCU password). See the sidebar for a warning on setting the password.

Password Warning
If you choose to set a boot password, NEVER forget your password.
The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
Memory Menu

**VGA Shared Memory (Memory Menu)**

This is the pre-allocated memory size for VGA compatibility. This is fixed at **32MB** by default, and can be adjusted to 16MB or 8MB. This memory is allocated from your system memory e.g. if you computer has 256MB of memory (RAM), then 32MB will be allocated to video leaving the system with 224MB of RAM.

---

Figure 5 - 3

Memory Menu
BIOS Utilities

Disks Menu

Figure 5 - 4
Disks Menu
(IDE Settings)

*IDE Settings (Disks Menu)*
You can use this menu to set the options for your hard disk and CD device. Only make changes if you are sure of what you are doing.

*Virus Alerts (Disks Menu)*
Enable this option to receive a warning if the area of the hard disk containing information on how to start up the computer is having information written to it. This can help warn you if viruses are attempting to affect this area. This is not a substitute for proper virus protection supplied by updated anti-virus software, merely an extra safeguard (see “Viruses” on page 7 - 4).
**Components Menu**

You can change the COM port settings from this menu. COM port A is the Touch Panel port, and COM port B is the infrared port.
BIOS Utilities

*Keyboard Numlock (Components Menu)*
Enable this mode to start the computer up with Number Lock enabled.

*Keyboard Repeat (Components Menu)*
Change the keyboard repeat rate and key delay from this menu.
Power Menu

This menu allows you to adjust the power saving options. If you are using a Windows OS, then the power saving options are best set there (see “Power Management Features” on page 3 - 17).
Low/Medium/High/Customize Power Saving (Power Menu)
You may choose to set power saving options for Low, Medium or High power savings in this menu, or alternatively you may Customize the settings to change the time until the hard disk goes into standby. These settings apply to Non-\textit{Windows} operating systems only (\textit{Windows} OS’s use the CPU Speed-Step Controls and/or the \textit{Windows} Power Management/Options as outlined in “Power Schemes” on page 3 - 19, 3 - 20 and “Advanced Power Saving” in Appendix A.

CPU SpeedStep Controls (Power Menu)
You can set the mode for the Intel CPU SpeedStep controls here (“\textit{Intel CPU SpeedStep Controls}” on page A - 3 gives full detail on the settings).

- Performance Mode Always - Enable this option to give maximum available performance when the battery is not low.
- Battery Optimized Mode Always - Enable this option to save maximum power when the computer is powered by battery.
- Automatically Switch (\textit{Default Setting}) - Enable this option to have the computer detect if it is powered by battery or AC adapter, and change the setting accordingly.

Turn on power for wireless devices (Power Menu)
You may choose to enable/disable power for the wireless devices from this menu option.
Exit Menu

Save and Exit (Exit Menu)
This option allows you to exit the SCU and save the changes you have made.
Exit (No Save) - (Exit Menu)
This option allows you to exit the SCU without saving any changes made.

Default Settings (Exit Menu)
This option allows you to reset the SCU settings to the original defaults before any changes were made to the system.

Restore Settings (Exit Menu)
This option will allow you to restore the SCU settings to the last changes you had made.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

- A small crosshead or Phillips screwdriver
- A small regular slotted screwdriver
- An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

- Replacing the Battery
- Replacing the HDD
- Upgrading the System Memory

Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.
Upgrading The Computer

6 - 2 Overview

When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replacing parts.

You should **not** perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).

**Power Safety Warning**

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.
Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery.

**Battery Removal Process**
1. Turn the computer off, and turn it over.
2. Locate the battery bay as highlighted in Figure 6 - 1.
3. Slide the battery lock in the direction of the arrow 1.
4. Slide the battery lock in the direction of the arrow 2, and hold it in place.
5. Slide the battery in the direction of the arrow 3, then lift it up and out of the computer's battery bay.

---

**Warranty Warning**
Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.
Upgrading the Hard Disk Drive

The hard disk drive can be taken out to accommodate other 2.5" IDE hard disk drives. Follow your operating system’s installation instructions, and install all necessary drivers and utilities (as outlined in “What to Install” on page 4 - 2), when setting up a new hard disk.

Hard Disk Upgrade Process

1. Turn off the computer, and turn it over and remove the battery.
2. Remove screw 1 from the hard disk cover.
3. Slide the hard disk assembly in the direction of the arrow 2.

Figure 6 - 2
HDD Release
4. Lift the hard disk assembly out of the computer.
5. Remove screws 1 - 4 from the hard disk case and remove the hard disk.
6. Reverse the process to install the new hard disk.

Figure 6 - 3
HDD Removal
Upgrading the System Memory (RAM)

The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-DIMM) - DDR 266 MHz - type memory modules. The main memory can be expanded up to 1024MB. The SO-DIMMs supported are 256MB, and 512MB in size, and the total memory size is automatically detected by the POST routine once you turn on your computer.

**Memory Upgrade Process**

1. Turn off the computer, and turn it over and remove the battery.
2. Remove screws 1 - 4 from the memory socket cover 5, and remove the cover.

*Figure 6 - 4*
Memory Socket Cover Removal
3. Gently pull the two release latches on the sides of the memory socket in the direction of the arrows (1 & 2 in Figure 6 - 5).

4. The module 3 will pop-up, and you can remove it.
5. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory slot.
6. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit without much pressure.
7. Press the module in and down towards the mainboard until the slot levers click into place to secure the module.
8. Replace the memory socket cover and the 4 screws (see Figure 6 - 4).
9. Restart the computer to allow the BIOS to register the new memory configuration as it starts up.

Contact Warning

Be careful not to touch the metal pins on the module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.

Figure 6 - 5
Removing/Installing a RAM Module

Upgrading the System Memory (RAM) 6 - 7
Upgrading The Computer

Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.

Unauthorized tampering with the HDD may also violate your warranty.
Chapter 7: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

- **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the LED Power Indicators (see “LED Power Indicators” on page 2 - 5) to see the computer’s power status.

- **Connections** - Check all the cables to make sure that there are no loose connections anywhere.

- **Power Savings** - Make sure that the system is not in Hibernate or Standby mode by pressing the keys configured in your Power Management/Power Options (see “Conserving Power (System)” on page 3 - 21), or by pressing the Fn + F4 key combination, to wake-up the system.

- **Brightness** - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness (see “Advanced Video Controls” on page 3 - 2).

- **Display Choice** - Press Fn + F7 to make sure the system is not set to only a monitor display (see “Function Key Combinations” on page 3 - 13).

- **Boot Drive** - Make sure there are no floppy disks in any floppy drive attached when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
Backup and General Maintenance

- Always **backup** your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the **serial numbers** if you are storing them out of their original cases, e.g. in a CD wallet.

- Run **maintenance programs** on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

- Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a **Boot** password for the SCU (see “**Boot and SCU Passwords (Startup Menu)” on page 5 - 10**).

- Keep copies of vital **settings files** such as network, dialup settings, mail settings etc. (even if just brief notes).

**Warranty**

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
Troubleshooting

Viruses

• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the virus may have infected an address book and been automatically forwarded without the person’s knowledge.

• Keep a “Boot Floppy Disk” or “Bootable CD-ROM” (this disk provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at least instructions on how to make one).
Upgrading and Adding New Hardware/Software

- Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

- Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

- Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

- When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

- Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).
Troubleshooting

• Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; Example - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
## Power

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned on the power but it doesn’t work.</td>
<td><em>Battery missing / incorrectly installed.</em> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The battery LED indicator is blinking orange and/or a beeping sound is heard.</td>
<td><em>Low Battery.</em> Plug in the AC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are losing battery power too quickly.</td>
<td><em>The system is using too much power.</em> If your OS has a <em>Power Options</em> scheme (see “Power Schemes” on page 3 - 19) check its settings. You may also be using a PC Card device that is drawing a lot of power.</td>
</tr>
<tr>
<td>Actual battery operating time is shorter than expected.</td>
<td><em>The battery has not been fully discharged before being recharged.</em> Make sure the battery is fully discharged and recharge it completely before reusing (see “Battery Information” on page 3 - 24).&lt;br&gt;<em>Power Options have been disabled.</em> Go to the <em>Control Panel</em> in <em>Windows</em> and re-enable the options.&lt;br&gt;<em>A peripheral device or PC Card is consuming a lot of power.</em> Turn off the unused device to save power.</td>
</tr>
</tbody>
</table>
The computer feels too hot.

Make sure the computer is properly ventilated and the vents/fan intakes are not blocked (see “Overheating” on page 1-16). If this doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface. Make sure you’re using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the vents/intakes to be blocked.
# Troubleshooting

## Display

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nothing appears on screen.</td>
<td><em>The system is in a power saving mode.</em> Toggle the sleep/resume key combination, <strong>Fn + F4</strong> (see “The Keyboard” on page 2 - 17).</td>
</tr>
<tr>
<td></td>
<td><em>The computer is set for a different display.</em> Toggle the screen display key combination, <strong>Fn + F7</strong>. If an external monitor is connected, turn it on.</td>
</tr>
<tr>
<td></td>
<td><em>The screen saver is activated.</em> Press any key or touch the TouchPad.</td>
</tr>
<tr>
<td>No image appears on the external monitor I have plugged in and powered on.</td>
<td><em>You haven’t installed the video driver and configured it appropriately from the Control Panel.</em> See “Video (Win2000)” on page 4 - 9 &amp; “Video (WinXP)” on page 4 - 15 for instructions on installing the driver (see “Making Adjustments for the Display” on page 3 - 6 for instructions on configuring the video driver).</td>
</tr>
<tr>
<td></td>
<td><em>You haven’t used the key combination to switch the display options.</em> Press the <strong>Fn + F7</strong> key combination to toggle through the options.</td>
</tr>
</tbody>
</table>

## Windows Media Player and Screen Rotation

If you are playing a DVD/VCD video in Windows Media Player, **do not rotate the screen while playing the video**. If you wish to rotate the screen, quit the Media Player program first, rotate the screen, then open the player to play the video.

Make sure the screen rotation driver (see “What to Install” on page 4 - 2) is installed before attempting to rotate the screen.
## Troubleshooting

### Boot Password

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You forget the boot password.</td>
<td><em>If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.</em></td>
</tr>
</tbody>
</table>

---

### Password Warning

If you choose to set a boot password, **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
## Audio

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The sound cannot be heard or the volume is very low.</td>
<td><em>The volume might be set too low.</em> Check the volume control in the <em>Volume Control Panel</em> in the <em>Windows</em> taskbar, or use the key combination <em>Fn + F5</em> and <em>F6</em> (see “<em>The Function Keys</em> on page 2 - 17”) to adjust.</td>
</tr>
<tr>
<td>The sound cannot be heard when playing an audio CD in an external USB CD device in the <em>Windows 2000</em> OS.</td>
<td><em>The digital CD audio needs to be enabled.</em> See “<em>Playing Audio CD’s in Windows 2000</em>” on page 2 - 10 for instructions on enabling CD audio for an external USB device.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### CD Device (Optional)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The compact disc cannot be read.</td>
<td><em>The compact disc is dirty</em>. Clean it with a CD-ROM cleaner kit.</td>
</tr>
<tr>
<td>The compact disc tray will not open when there is a disc in the tray.</td>
<td><em>The compact disc is not correctly placed in the tray</em>. Gently try to remove the disc using the eject hole (see “Loading CDs or DVDs” on page 2 - 11).</td>
</tr>
<tr>
<td>The system cannot read from the optional CD/DVD device.</td>
<td><em>The system cannot not read from the optional USB 2.0 CD/DVD device</em>. When used with your computer the optional USB 2.0 CD/DVD device must be powered by an AC power source via the AC adapter. When used with the AC adapter make sure the power switch is set to <strong>EXT</strong> (external power).</td>
</tr>
<tr>
<td>The regional codes can no longer be changed.</td>
<td>The regional codes have already changed the maximum 5 times - See “<strong>DVD Regional Codes</strong>” on page 2 - 12.</td>
</tr>
</tbody>
</table>
Troubleshooting

Keyboard and Mouse

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unwelcome numbers appear when typing.</td>
<td>If the LED is lit, then Num Lock is turned ON. Press and release the Fn &amp; Num Lk key combination (see “Numeric Keypad” on page 2 - 18).</td>
</tr>
</tbody>
</table>

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot keys unique to the system's regular keyboard may not work.
### Troubleshooting

#### Operation

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The system performance appears to be getting slower.</td>
<td><em>The system’s power saving features have reduced CPU performance in order to save power.</em> The Power Schemes setting in Windows, or the Intel CPU SpeedStep settings can be configured to reduce CPU speed and performance in order to save power. See “Power Schemes” on page 3 - 19 and “Advanced Power Saving” on page A - 1 for more information on adjusting the settings.</td>
</tr>
<tr>
<td>The system freezes or the screen goes dark.</td>
<td><em>The system’s power saving features have timed-out.</em> Use the AC adapter, press the sleep key combination, or press the power button (see “Configuring the Power Button” on page 3 - 23).</td>
</tr>
<tr>
<td>The system never goes into Hibernate mode.</td>
<td>Make sure you have enabled Hibernate in the Power Options control panel in your OS (see “Hibernate” on page 3 - 22).</td>
</tr>
<tr>
<td>The system turns goes in to a power saving mode when rotating the swivel screen.</td>
<td><em>The swivel screen has accidentally hit the left LCD cover sensor, and triggered a power saving mode, when rotating the LCD swivel screen.</em> It is recommended that you set the lid (left LCD cover sensor) power button to “Do nothing”.</td>
</tr>
</tbody>
</table>
| The infrared device and the computer cannot communicate with each other. | *The infrared port is blocked.* Make sure nothing is between your system’s infrared port and the destination’s port.  
*The computer’s settings for Fast Infrared (FIR) are not configured.* Follow the steps in “Configuring the Infrared Transceiver” on page 2 - 26. |
Appendix A: Advanced Power Saving

This Appendix contains information on Power Schemes and how they affect the computer’s CPU performance, and information on Intel CPU Speed Step controls.
Power Schemes & Processor Performance

*Windows* defines four control policies (see sidebar) used with each power scheme.

<table>
<thead>
<tr>
<th>Power Scheme</th>
<th>AC Power</th>
<th>DC Power</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home/Office Desk</td>
<td>None</td>
<td>Adaptive</td>
</tr>
<tr>
<td>Portable/Laptop</td>
<td>Adaptive</td>
<td>Adaptive</td>
</tr>
<tr>
<td>Presentation</td>
<td>Adaptive</td>
<td>Degrade</td>
</tr>
<tr>
<td>Always On</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Minimal Power Management</td>
<td>Adaptive</td>
<td>Adaptive</td>
</tr>
<tr>
<td>Max Battery</td>
<td>Adaptive</td>
<td>Degrade</td>
</tr>
</tbody>
</table>

*Table A - 1
Power Scheme Control Policies

Set the **Power Scheme** which is most appropriate for the conditions and the applications you are using (e.g. games, 3D applications, audio and video programs etc. usually require high CPU performance). See also *Table A-2 on page A - 7/Table A-3 on page A - 8* for further information on power saving settings and CPU performance.
Intel CPU SpeedStep Controls

Additional controls are available to support the Intel Pentium M processor’s mobile power management features. (It is not necessary to download and run the updated driver if you have an Intel Celeron M processor, however Table A-3 on page A - 8 lists the CPU SpeedStep settings for Celeron M processors.) These controls may be adjusted in the Intel CPU SpeedStep settings in the BIOS. See “BIOS Utilities” on page 5 - 1 for details on how to access the BIOS utilities, and “CPU SpeedStep Controls (Power Menu)” on page 5 - 16 for the specific menu.

Windows 2000 and Windows XP with Service Pack 1 installed support the basic features of the Intel CPU SpeedStep controls. As long as you have Windows XP with Service Pack 1 installed, you may download and install an additional processor driver to support additional features such as Intel Enhanced SpeedStep Technology and Intel Deeper Alert Sleep State. The instructions on downloading the driver are in the sidebar. You can check if your current processor driver for Windows XP (with Service Pack 1 installed) needs to be updated by following the procedure listed on the following pages:

Windows XP Service Pack 1 Driver to Support Power Management Features

The driver that supports the mobile processor power management features of Intel Pentium M Processors will be installed if you automatically update your Windows XP version (you must have Service Pack 1 installed) from the Microsoft website. Further information is available if you search the Microsoft website for article Q332179 (enter the article number in the search box and click Go).
Checking the Processor Driver Version

1. If you can see the My Computer icon on your desktop (if you cannot see the My Computer icon go to step 2) click on it once to select it, then right-click it to make the sub-menu appear and scroll down to Properties and click on it (go to step 3).

2. If you cannot see the My Computer icon click Start (menu), then point to (but don’t click just highlight it) My Computer. Right-click it to make the sub-menu appear and scroll down to Properties and click on it (go to step 3).

3. Click the Hardware (tab), then click Device Manager (button).

4. Click “+” next to Processors (if its sub-items are not shown).

5. Double-click Intel(R) Pentium(R) M processor 1*00MHz and click Driver (tab).

6. Click Driver Details (button).

7. If the driver is the updated version, the suffix gv3.sys will appear in the Driver files box, and you do not need to update it (see Figure A - 1 on the following page).
If you do not see the suffix `gv3.sys` you will need to download and install the driver (see the instructions on page A - 3). When the driver is downloaded follow the two part instructions on the following page to install and run the driver (you will need to Unzip the contents of the Zip file to a location on your hard disk).
Installing the Driver

1. If you can see the **My Computer** icon on your desktop (if you cannot see the **My Computer** icon go to step 2) click on it once to select it, then right-click it to make the sub-menu appear and scroll down to **Properties** and click on it (go to step 3).

2. If you cannot see the **My Computer** icon click **Start** (menu), then point to (but don’t click just highlight it) **My Computer**. Right-click it to make the sub-menu appear and scroll down to **Properties** and click on it (go to step 3).

3. Click the **Hardware** (tab), then click **Device Manager** (button).

4. Click “+” next to **Processors** (if its sub-items are not shown).

5. Double-click **Intel(R) Pentium(R) M processor 1*00MHz** and click **Driver** (tab).

6. Click **Update Driver** (button).

7. When the **Hardware Update Wizard** appears, click “Install from a list or specific location (Advanced)” then click **Next**.

8. Select “Search for the best driver in these locations.” and select ONLY “Include this location in the search:”.

9. Navigate (Browse...) to the **GV3 Folder** (the location where you have unzipped the downloaded file) and click **OK** > **Next**.

10. Click **Finish > Yes** to restart your computer.

11. After the restart browse to the **GV3 Folder** (the location where you have unzipped the downloaded file) and run the **Q330512_WXP_SP2_X86.EXE** file.

---

**CPU Performance with SpeedStep**

The CPU SpeedStep options will adjust the speed of the CPU according to the setting in the BIOS, and in some cases this will reduce the CPU performance in order to conserve power consumption (generally speaking the higher the speed a CPU runs, the more power it will consume). You will need to set the **CPU SpeedStep** settings (and the **Windows Power Scheme** settings) in order to gain a balance between good performance and power saving.
**CPU SpeedStep Settings for Pentium M Processors**

<table>
<thead>
<tr>
<th>Power Source</th>
<th>CPU Speed</th>
<th>Power Source</th>
<th>CPU Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Performance Mode Always</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AC In</td>
<td>CPU Max Speed</td>
<td>AC In</td>
<td>600MHz ~ Max Speed*</td>
</tr>
<tr>
<td>Battery (not low)</td>
<td>1300MHz</td>
<td>Battery (not low)</td>
<td>600MHz ~ 1300MHz</td>
</tr>
<tr>
<td>Low Battery</td>
<td>600MHz</td>
<td>Low Battery</td>
<td>600MHz</td>
</tr>
<tr>
<td><strong>Battery Optimized Mode Always</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AC In</td>
<td>600MHz</td>
<td>AC In</td>
<td>600MHz</td>
</tr>
<tr>
<td>Battery (not low)</td>
<td>600MHz</td>
<td>Battery (not low)</td>
<td>600MHz</td>
</tr>
<tr>
<td>Low Battery</td>
<td>600MHz</td>
<td>Low Battery</td>
<td>600MHz</td>
</tr>
<tr>
<td><strong>Automatically Switch</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AC In</td>
<td>CPU Max Speed</td>
<td>AC In</td>
<td>600MHz ~ Max Speed*</td>
</tr>
<tr>
<td>Battery (not low)</td>
<td>600MHz</td>
<td>Battery (not low)</td>
<td>600MHz</td>
</tr>
<tr>
<td>Low Battery</td>
<td>600MHz</td>
<td>Low Battery</td>
<td>600MHz</td>
</tr>
</tbody>
</table>

*Max Speed* as defined by the Power Scheme set in *Windows (page A - 2).* The Above table applies to Pentium M processors only.

You can adjust the SpeedStep control settings from the BIOS (see “CPU SpeedStep Controls (Power Menu)” on page 5 - 16). The default BIOS setting is *Automatically Switch.* However if the CPU settings are at *Max Speed,* the CPU speed will still be affected by the *Windows Power Scheme* setting (this may also adjust the CPU speed).

**Table A - 2**

Pentium M CPU SpeedStep Settings
The Above table applies to Intel Celeron M processors only.

### CPU SpeedStep Settings for Celeron M Processors

<table>
<thead>
<tr>
<th>Power Source</th>
<th>Celeron M 1200MHz CPU Speed</th>
<th>Celeron M 1300MHz CPU Speed</th>
<th>Celeron M 1400MHz CPU Speed</th>
<th>Celeron M 1500MHz CPU Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC In</td>
<td>1200MHz</td>
<td>1300MHz</td>
<td>1400MHz</td>
<td>1500MHz</td>
</tr>
<tr>
<td>Battery (not low)</td>
<td>1200MHz</td>
<td>1300MHz (1225MHz)</td>
<td>1225MHz</td>
<td>1312MHz</td>
</tr>
<tr>
<td>Low Battery</td>
<td>600MHz</td>
<td>650MHz</td>
<td>525MHz</td>
<td>562MHz</td>
</tr>
</tbody>
</table>

### Performance Mode Always

<table>
<thead>
<tr>
<th>Power Source</th>
<th>Celeron M 1200MHz CPU Speed</th>
<th>Celeron M 1300MHz CPU Speed</th>
<th>Celeron M 1400MHz CPU Speed</th>
<th>Celeron M 1500MHz CPU Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC In</td>
<td>600MHz</td>
<td>650MHz</td>
<td>525MHz</td>
<td>562MHz</td>
</tr>
<tr>
<td>Battery (not low)</td>
<td>600MHz</td>
<td>650MHz</td>
<td>525MHz</td>
<td>562MHz</td>
</tr>
<tr>
<td>Low Battery</td>
<td>600MHz</td>
<td>650MHz</td>
<td>525MHz</td>
<td>562MHz</td>
</tr>
</tbody>
</table>

### Battery Optimized Mode Always

<table>
<thead>
<tr>
<th>Power Source</th>
<th>Celeron M 1200MHz CPU Speed</th>
<th>Celeron M 1300MHz CPU Speed</th>
<th>Celeron M 1400MHz CPU Speed</th>
<th>Celeron M 1500MHz CPU Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC In</td>
<td>1200MHz</td>
<td>1300MHz</td>
<td>1400MHz</td>
<td>1500MHz</td>
</tr>
<tr>
<td>Battery (not low)</td>
<td>600MHz</td>
<td>650MHz</td>
<td>525MHz</td>
<td>562MHz</td>
</tr>
<tr>
<td>Low Battery</td>
<td>600MHz</td>
<td>650MHz</td>
<td>525MHz</td>
<td>562MHz</td>
</tr>
</tbody>
</table>

### Automatically Switch

<table>
<thead>
<tr>
<th>Power Source</th>
<th>Celeron M 1200MHz CPU Speed</th>
<th>Celeron M 1300MHz CPU Speed</th>
<th>Celeron M 1400MHz CPU Speed</th>
<th>Celeron M 1500MHz CPU Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC In</td>
<td>1200MHz</td>
<td>1300MHz</td>
<td>1400MHz</td>
<td>1500MHz</td>
</tr>
<tr>
<td>Battery (not low)</td>
<td>600MHz</td>
<td>650MHz</td>
<td>525MHz</td>
<td>562MHz</td>
</tr>
<tr>
<td>Low Battery</td>
<td>600MHz</td>
<td>650MHz</td>
<td>525MHz</td>
<td>562MHz</td>
</tr>
</tbody>
</table>

---

**Table A - 3**

Celeron M CPU SpeedStep Settings

You can adjust the SpeedStep control settings from the BIOS (see “CPU SpeedStep Controls (Power Menu)” on page 5 - 16). The default BIOS setting is Automatically Switch. However if the CPU settings are at the maximum speed, the CPU speed will still be affected by the Windows Power Scheme setting (this may also adjust the CPU speed).
## Appendix B: Model A Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processor Types</strong></td>
<td>Intel Pentium® M Processor (478-pin) Micro-FCPGA Package</td>
</tr>
<tr>
<td></td>
<td>(µ0.13) 0.13 Micron Process Technology, 1MB On-Die L2 Cache &amp; 400MHz Front Side Bus - 1.3/ 1.4/ 1.5/ 1.6/ 1.7 GHz</td>
</tr>
<tr>
<td></td>
<td>Intel Pentium® M Processor (478-pin) Micro-FCPGA Package</td>
</tr>
<tr>
<td></td>
<td>(90nm) 90 Nanometer Process Technology, 2MB On-Die L2 Cache &amp; 400MHz Processor System Bus - 1.7/ 1.8/ 1.9 GHz</td>
</tr>
<tr>
<td></td>
<td>Intel Celeron® M Processor (478-pin) Micro-FCPGA Package</td>
</tr>
<tr>
<td></td>
<td>(µ0.13) 0.13 Micron Process Technology, 512KB On-Die L2 Cache &amp; 400MHz Processor System Bus - 1.2/ 1.3/ 1.4 GHz</td>
</tr>
<tr>
<td><strong>Core Logic</strong></td>
<td>Intel® 855 GM(E) + Intel 82801DBM (ICH4-M)</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>Security (Kensington® Type) Lock Slot</td>
</tr>
<tr>
<td></td>
<td>BIOS Password</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>Two 200 Pin DDR SODIMM Sockets Supporting DDR 266/333 MHz Modules</td>
</tr>
<tr>
<td></td>
<td>Supporting 256/512MB DDR RAM Modules Expandable up to 1024 MB</td>
</tr>
<tr>
<td><strong>BIOS</strong></td>
<td>ACPI 4MB Flash ROM Insyde BIOS</td>
</tr>
<tr>
<td><strong>LCD</strong></td>
<td>Flat Panel TFT - 14.1&quot; XGA LCD with Built-in Touch Panel and Stylus Pen</td>
</tr>
<tr>
<td></td>
<td>Supporting 1024 * 768 dot resolution</td>
</tr>
<tr>
<td></td>
<td>LCD Swivel Hinge (allows conversion between Notebook and Tablet Modes)</td>
</tr>
<tr>
<td>Feature</td>
<td>Specification</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display</td>
<td>Intel Chipset 855GM Integrated Graphics</td>
</tr>
<tr>
<td></td>
<td>Shared Video Memory Architecture Supporting up to 32MB (Default Setting 32MB)</td>
</tr>
<tr>
<td>Storage</td>
<td>Easy Changeable 2.5&quot; 9.5 mm (h) IDE HDD</td>
</tr>
<tr>
<td></td>
<td>Supporting Ultra DMA 66/100</td>
</tr>
<tr>
<td></td>
<td>Built-in 4-in-1 Card Reader for the following formats:</td>
</tr>
<tr>
<td></td>
<td>SD (Secure Digital)</td>
</tr>
<tr>
<td></td>
<td>MMC (Multi Media Card)</td>
</tr>
<tr>
<td></td>
<td>MS (Memory Stick)</td>
</tr>
<tr>
<td></td>
<td>SM (Smart Media Card)</td>
</tr>
<tr>
<td>Audio</td>
<td>Integrated Direct Sound Audio Compliant with AC’97 2.2</td>
</tr>
<tr>
<td></td>
<td>2 Built-In Speakers</td>
</tr>
<tr>
<td>Keyboard, Pointing Device &amp;</td>
<td>Winkey Keyboard</td>
</tr>
<tr>
<td>Buttons</td>
<td>Built-In TouchPad</td>
</tr>
<tr>
<td></td>
<td>4 Hardware Buttons:</td>
</tr>
<tr>
<td></td>
<td>“Q” for screen rotation/power</td>
</tr>
<tr>
<td></td>
<td>Tab</td>
</tr>
<tr>
<td></td>
<td>Escape</td>
</tr>
<tr>
<td></td>
<td>Scroll Up/Scroll Down/Enter</td>
</tr>
<tr>
<td>Indicators</td>
<td>7 LED Indicators (Power/Suspend, Battery, HDD, Caps Lock, Scroll Lock, Num</td>
</tr>
<tr>
<td></td>
<td>Lock, Wireless LAN</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Specification</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Interface & Communication** | Two USB 2.0/1.1 Ports  
One Stereo Headphone-Out Jack  
One Monaural Microphone-In Jack  
One RJ-11 (V.90 K56flex™) Jack for Fax/Modem  
MDC Modem Module Supporting Wake On Ring |
|                        | One RJ-45 Jack for 100M (Max) Fast Ethernet  
Intel Pro 2100 (802.11b) Mini PCI Wireless LAN Module  
One External (VGA) Monitor Port  
One DC-in Jack  
One Infrared FIR, IrDA 1.1 Transceiver  
One Type II PCMCIA 3.3V/5V Socket Supporting CardBus |
| **Power Management**    | Supports ACPI v1.0b  
Supports Hibernate Mode  
Supports Standby Mode  
Supports Battery Low Sleep |
|                        | Supports Resume From Modem Ring  
Supports Resume From LAN Ring  
Close Cover Switch |
| **Power**               | Full Range AC adapter  
AC Input 100~240V, 50~60Hz  
DC Output 20V, 3.25A, **65W** |
|                        | One Primary Smart Lithium-Ion (1800mAH x 6 cells) Battery Pack with Gas Gauge |
| **Environmental Spec**  | **Temperature**  
Operating: 5°C ~ 35°C  
Non-Operating: -20°C ~ 60°C |
|                        | **Relative Humidity**  
Operating: 20% ~ 80%  
Non-Operating: 10% ~ 90% |
| **Physical Dimensions & Weight** | 313 (w) x 265 (d) x 26.5/29.5(h) mm  
2.3 Kg Without Battery |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>PC Camera (factory option)</td>
</tr>
<tr>
<td></td>
<td>Smart Lithium-Ion Battery Pack)</td>
</tr>
<tr>
<td></td>
<td>Standard - 1800mAh x 6 cells (40W)</td>
</tr>
<tr>
<td></td>
<td>Optional - 1800mAh x 8 cells (53W)</td>
</tr>
<tr>
<td></td>
<td>External FDD with USB Interface</td>
</tr>
<tr>
<td></td>
<td>External Slim Optical Drive with One of the Following Options:</td>
</tr>
<tr>
<td></td>
<td>CD-ROM</td>
</tr>
<tr>
<td></td>
<td>DVD-ROM</td>
</tr>
<tr>
<td></td>
<td>CD-RW</td>
</tr>
<tr>
<td></td>
<td>Combo</td>
</tr>
<tr>
<td></td>
<td>DVD-RW</td>
</tr>
<tr>
<td></td>
<td>DVD+RW</td>
</tr>
<tr>
<td></td>
<td>Handwriting Application</td>
</tr>
<tr>
<td></td>
<td>Car Adapter</td>
</tr>
</tbody>
</table>
## Appendix C: Model B Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processor Types</strong></td>
<td></td>
</tr>
<tr>
<td>Intel Pentium® M Processor (478-pin) Micro-FCPGA Package</td>
<td>(µ0.13) 0.13 Micron Process Technology, 1MB On-Die L2 Cache &amp; 400MHz Front Side Bus - 1.3/1.4/1.5/1.6/1.7 GHz</td>
</tr>
<tr>
<td>Intel Pentium® M Processor (478-pin) Micro-FCPGA Package</td>
<td>(90nm) 90 Nanometer Process Technology, 2MB On-Die L2 Cache &amp; 400MHz Processor System Bus - 1.7/1.8/1.9 GHz</td>
</tr>
<tr>
<td>Intel Celeron® M Processor (478-pin) Micro-FCPGA Package</td>
<td>(µ0.13) 0.13 Micron Process Technology, 512KB On-Die L2 Cache &amp; 400MHz Processor System Bus - 1.2/1.3/1.4 GHz</td>
</tr>
<tr>
<td><strong>Core Logic</strong></td>
<td>Intel® 855 GM(E) + Intel 82801DBM (ICH4-M)</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>Security (Kensington® Type) Lock Slot BIOS Password</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>Two 200 Pin DDR SODIMM Sockets Supporting DDR 266/333 MHz Modules</td>
</tr>
<tr>
<td></td>
<td>Supporting 256/512MB DDR RAM Modules Expandable up to 1024 MB</td>
</tr>
<tr>
<td><strong>BIOS</strong></td>
<td>ACPI 4MB Flash ROM Insyde BIOS</td>
</tr>
<tr>
<td><strong>LCD</strong></td>
<td>Flat Panel TFT - 14.1&quot; XGA LCD with Built-in Touch Panel and Stylus Pen</td>
</tr>
<tr>
<td></td>
<td>Supporting 1024 * 768 dot resolution</td>
</tr>
<tr>
<td></td>
<td>LCD Swivel Hinge (allows conversion between Notebook and Tablet Modes)</td>
</tr>
<tr>
<td>Feature</td>
<td>Specification</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display</td>
<td>Intel Chipset 855GM Integrated Graphics</td>
</tr>
<tr>
<td></td>
<td>Shared Video Memory Architecture Supporting up to 32MB (Default Setting 32MB)</td>
</tr>
<tr>
<td>Storage</td>
<td>Easy Changeable 2.5&quot; 9.5 mm (h) IDE HDD</td>
</tr>
<tr>
<td></td>
<td>Supporting Ultra DMA 66/100</td>
</tr>
<tr>
<td></td>
<td>Built-in 4-in-1 Card Reader for the following formats:</td>
</tr>
<tr>
<td></td>
<td>SD (Secure Digital)</td>
</tr>
<tr>
<td></td>
<td>MMC (Multi Media Card)</td>
</tr>
<tr>
<td></td>
<td>MS (Memory Stick)</td>
</tr>
<tr>
<td></td>
<td>SM (Smart Media Card)</td>
</tr>
<tr>
<td>Audio</td>
<td>Integrated Direct Sound Audio Compliant with AC'97 2.2</td>
</tr>
<tr>
<td></td>
<td>2 Built-In Speakers</td>
</tr>
<tr>
<td>Keyboard, Pointing</td>
<td>Winkey Keyboard</td>
</tr>
<tr>
<td>Device &amp; Buttons</td>
<td>Built-In TouchPad</td>
</tr>
<tr>
<td></td>
<td>4 Hardware Buttons:</td>
</tr>
<tr>
<td></td>
<td>“Q” for screen rotation/power</td>
</tr>
<tr>
<td></td>
<td>Tab</td>
</tr>
<tr>
<td></td>
<td>Escape</td>
</tr>
<tr>
<td></td>
<td>Scroll Up/Scroll Down/Enter</td>
</tr>
<tr>
<td>Indicators</td>
<td>7 LED Indicators (Power/Suspend, Battery, HDD, Caps Lock, Scroll Lock, Num Lock, Wireless LAN)</td>
</tr>
<tr>
<td>Feature</td>
<td>Specification</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Interface & Communication** | Two USB 2.0/1.1 Ports  
One Stereo Headphone-Out Jack  
One Monaural Microphone-In Jack  
One RJ-11 (V.90 K56flex™) Jack for Fax/Modem  
MDC Modem Module Supporting Wake On Ring  
One RJ-45 Jack for 100M (Max) Fast Ethernet  
Intel Pro 2100 (802.11b) Mini PCI Wireless LAN Module  
One External (VGA) Monitor Port  
One DC-in Jack  
One Infrared FIR, IrDA 1.1 Transceiver  
One Type II PCMCIA 3.3V/5V Socket Supporting CardBus |
| **Power Management**        | Supports ACPI v1.0b  
Supports Hibernate Mode  
Supports Standby Mode  
Supports Battery Low Sleep  
Supports Resume From Modem Ring  
Supports Resume From LAN Ring  
Close Cover Switch |
| **Power**                   | Full Range AC adapter  
AC Input 100~240V, 50~60Hz  
DC Output 20V, 3.25A, **65W**  
One Primary Smart Lithium-Ion (1800mAh x 6 cells) Battery Pack with Gas Gauge |
| **Environmental Spec**      | **Temperature**  
Operating: 5°C ~ 35°C  
Non-Operating: -20°C ~ 60°C  
**Relative Humidity**  
Operating: 20% ~ 80%  
Non-Operating: 10% ~ 90% |
| **Physical Dimensions & Weight** | 313 (w) x 265 (d) x 26.5/29.5(h) mm  
2.3 Kg Without Battery |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>PC Camera (factory option)</td>
</tr>
<tr>
<td></td>
<td>Smart Lithium-Ion Battery Pack)</td>
</tr>
<tr>
<td></td>
<td>Standard - 1800mAH x 6 cells (40W)</td>
</tr>
<tr>
<td></td>
<td>Optional - 1800mAH x 8 cells (53W)</td>
</tr>
<tr>
<td></td>
<td>External FDD with USB Interface</td>
</tr>
<tr>
<td></td>
<td>External Slim Optical Drive with One of the Following Options:</td>
</tr>
<tr>
<td></td>
<td>CD-ROM</td>
</tr>
<tr>
<td></td>
<td>DVD-ROM</td>
</tr>
<tr>
<td></td>
<td>CD-RW</td>
</tr>
<tr>
<td></td>
<td>Combo</td>
</tr>
<tr>
<td></td>
<td>DVD-RW</td>
</tr>
<tr>
<td></td>
<td>DVD+RW</td>
</tr>
<tr>
<td></td>
<td>Handwriting Application</td>
</tr>
<tr>
<td></td>
<td>Car Adapter</td>
</tr>
</tbody>
</table>